Micro Focus Enterprise Server 5.0

Release Notes
Micro Focus Enterprise Server 5.0 Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety before you install the product.

Note:

- This document contains a number of links to external Web sites. Micro Focus cannot be responsible for the contents of the Web site or for the contents of any site to which it might link. Web sites by their nature can change very rapidly and although we try to keep our links up-to-date, we cannot guarantee that they will always work as expected.
- Check the Product Documentation section of the Micro Focus SupportLine Web site for any updates to the documentation which might have been uploaded.

Product Overview

Enterprise Server provides the execution environment for applications created with any IDE variant of Enterprise Developer.

Upgrading from earlier Micro Focus products

Note: This applies to Windows platforms only.

This version of your product is dependent on a later version of the Microsoft C run-time system than earlier Micro Focus products. This means that COBOL executables (.exe) built with a version earlier than 4.0 might not be compatible with the current version of the run-time products. If the behavior of your application changes with the current version, we strongly recommend that you relink the main executable with the current version. This will ensure that the COBOL run-time system fully handles any run-time error conditions that might occur.

A new executable that is fully compatible with the current version can be produced without recompiling the application, as long as the original object code is available and it is relinked with the current version.

To allow your executables to benefit from the product's latest programming and performance enhancements, we recommend a full recompilation of your source code.
What's New

This release provides enhancements in the following areas:

- Amazon Web Services Quick Start for Enterprise Server
- Enterprise Server and Scale Out Architecture
- Enterprise Server Common Web Administration
- CICS Support
- Consolidated Trace Facility
- Data File Tools
- Database Access
- Enterprise Server Security
- JCL Support
- Mainframe Access
- Micro Focus Native Database File Handler
- PL/I Support
- Platform Support

Amazon Web Services Quick Start for Enterprise Server

Micro Focus has worked with Amazon Web Services (AWS) to create an AWS Quick Start for Enterprise Server. The Quick Start includes AWS CloudFormation templates and a deployment guide with step-by-step instructions that enable you to deploy Enterprise Server into a new or existing virtual private cloud (VPC) on the AWS Cloud in about 1 hour and 15 minutes.

For full information see Micro Focus Enterprise Server on AWS (click here).

Enterprise Server and Scale Out Architecture

Note: This feature is in Early Adopter Product (EAP) release status.

This release offers an enhanced and improved availability, and serviceability of Enterprise Server through the ability to administer and maintain a cross-system group of regions as a single system image with the new Performance and Availability Cluster (PAC).

In order for different Enterprise Server instances to be able to work together, they need to be able to share data. This is achieved through the use of a Scale Out Repository (SOR). All ES instances in a PAC will have a common SOR (PSOR) which is used to store CICS resources (limited to PCTs, PPTs, FCTs, DCTs and TSTs in this release) as well as internal system data to facilitate synchronisation between instances. Temporary Storage Queues and Transient Data Queues can also be shared between Enterprise Server instances by directing them to a SOR. Benefits of using PACs and SORs in this way include:

- Reduced hardware costs - taking advantage of the PAC to scale-out rather than scaling-up for more efficient use of processor resources.
- Easier maintenance - Dynamically adding or removing of regions to the PAC for system maintenance.
• Increased availability - in the event of the failure of an Enterprise Server instance, the PAC can continue to operate with reduced capacity. Enterprise Server instances can reside on different machines, improving availability further.
• Dynamic scaling - Enterprise Server instances can be added to, or removed from, the PAC depending on demand.
• Better performance - throughput is no longer restricted by the resources on a single machine (scale-up).
• Improved serviceability - you can now administer the PAC and any associated regions as a single image from a new contemporary web-based administration interface (ESCWA).

**Enterprise Server Common Web Administration**

*Note:* This feature is in Early Adopter Product (EAP) release status.

Enterprise Developer now includes a new Enterprise Server Common Web Administration interface (ESCWA). ESCWA is a web user interface and server for modern administration, monitoring and control of Enterprise Server. It offers improved usability that consolidates the different Enterprise Server user interfaces so that native and managed regions, and security stores can be managed in one place. Features include:

• Administering directory servers across multiple hosts.
• Monitoring and control of CICS and JES Enterprise Server instances.
• Configuring and administering a security store, defined in an LDAP-compatible security manager such as Microsoft Active Directory or OpenLDAP.
• Administering the Scale-Out features - enable you to specify logical groups of Enterprise Server instances, and configure and run Performance Availability Clusters (PACs) and their related Scale-Out Repositories (SORs).
• Administering, monitoring and control of Enterprise Server for .NET regions and listeners.
• The use of current web frameworks that have a greater focus on security.
• (Included with 5.0 Patch Update 2) - support for Enterprise Server XA, MQ and PL/I configuration and monitoring. This includes support for XA resources, configuring MQ, Listeners and Writers, PL/I, MFCS console, Region Trace options, displaying the current ESMs on logon page and Local/loopback connections warning changes.

**CICS Support**

*Note:* This feature is in Early Adopter Product (EAP) release status.

This release includes the following enhancements:

• CRCN CICS transaction - this new in-built CICS transaction monitors the state of XA connections for each resource manager (RM) entry defined in the system. If CRCN finds that connections have become unavailable, it will attempt to reconnect at regular intervals. (The frequency of the monitoring is controlled by the ES_XA_RECONNECT environment variable,) CRCN will emit messages to the console to warn of connections lost and regained.

**Consolidated Trace Facility (CTF)**

*Note:* This feature is in Early Adopter Product (EAP) release status.

This release provides the following enhancements:
• Dynamic CTF - it is now possible to configure the CTF dynamically from outside the process being traced.

Using a new command line utility - cblctd - you can alter the tracing events of running applications that already have CTF tracing enabled. You can alter trace levels, add or remove components to or from the trace, and also configure the emitters in effect.

Additionally, there is also a new component that you can trace - mf.mfdbfh enables you to trace activity of the Micro Focus Native Database File Handler.

Data File Tools

This release provides the following enhancements:

• The Data File Editor now includes a Compare Files tool that enables you to compare the contents of two data files side-by-side.
• Structure files, and the layouts within them, can now be created within the Data File Editor; you no longer need to use the Classic Data File Tools utility to manage your layouts.
• When connecting to a VSAM dataset stored in an enterprise server region, you can store any passwords required for access, for the duration of your current session.
• You can view archived JES spool jobs that have been merged into one spool file using the merging archived spool files process.
• You can now quickly duplicate records in non-indexed files, using the Duplicate Record option.

Database Access

Enhancements are available in the following areas:

OpenESQL ADO.NET Connection Editor Toolbar

• A new "i" (information) button is available that provides all the details of any installed .NET provider. Provides additional information mitigating resource definition and use within the ADO.NET Connection editor
• Static XA switch modules "Reconnect" - At the beginning of a global transaction, the XA switch will attempt to reconnect temporarily broken connections to the database. If there is a temporary disconnect to the database, there is no need to manually re-enable the XA switch to run transactions.

Enterprise Server Security

This release includes the following enhancements:

• Security - security features can now be employed when developers and administrators install new COBOL services (web services and EJBs) into an enterprise server instance over the network. There are a number of authentication and authorization options that can be enabled. See Deployment Listeners and The .mfdeploy File in your product Help.
• Vault Facility - a new security feature has been added that enables some Enterprise Server components to keep certain sensitive information in a form of storage defined as a vault, accessible via a configurable vault provider. The default vault provider stores data in encrypted format on disk.
• OpenSSL 1.1.1 - the OpenSSL security provider has been updated to OpenSSL version 1.1.1.
This is the stable Long Term Support version of OpenSSL.

- Added support for the ratified TLS protocol version 1.3. TLS 1.3 benefits include:
  - Much shorter initial connection negotiation sequence. This reduces the time taken to establish a link before starting to transmit data.
  - Using only the most secure ciphers and hash methods.
  - TLS 1.3 will be negotiated in preference to the older TLS protocols.
- Added support for new Ciphers and Key Exchange groups in line with TLS 1.3 requirements.
- The default security level for previously configured endpoints has been moved from Security Level 0 to Security Level 1. This removes the ability to accidentally make use of known-weak elements such as SSL3 and MD5. Similar changes to the default Security Level have recently happened to Java, Chrome, Firefox, and other systems providing secure connections.
- Fileshare Security - the Fileshare Secure TCP/IP transport provider now supports the trusted use of X509 certificates bearing the name of the Fileshare service as the Common Name element of the certificate.

In previous releases, a secure connection to a Fileshare server was made using a certificate that represented the network location upon which the Fileshare service was located. This method is still supported, but does not distinguish between the exact Fileshare server that is being connected to when more than one service can exist on a single host system. With this change, individual Fileshare services can identify themselves by using a unique certificate. While running on the same host and registered with the same network endpoint.

- Support for Active Directory user groups and group name mapping - the Enterprise Server External Security Facility's MLDAP ESM Module can now use Active Directory user group objects for Enterprise Server user groups. Also, the module can now map long group names to the 8-character-maximum names required for mainframe emulation.
- Selective auditing - administrators can audit only security activity of particular interest, reducing audit overhead and the volume of events. The Enterprise Server External Security Facility's MLDAP ESM Module can now enable ESF Audit events only for particular users, groups, and resources.
- Improved interaction with LDAP client libraries resulting in fewer LDAP-related issues and easier diagnostics - the Enterprise Server External Security Facility's MLDAP ESM Module has improved interoperation with LDAP client libraries:
  - The client library vendor and version information is logged after the library is loaded
  - The module has better heuristics for loading the correct library supplied by the OS vendor, so the "provider" configuration option can generally be omitted
  - For OpenLDAP, the module sets its proprietary "connect timeout" option
- SNI support (requires 5.0 Patch Update 1 or later) - support has been added in Patch Update 1 for the Server Name Identification (SNI) extension to TLS. This helps to avoid connectivity issues related to a growing number of Web services being hosted on SNI servers.

## JCL Support

*Back to Top*

This release includes the following enhancements:

- Spool file housekeeping - you can now merge your archived spool files to a central location where they can be viewed using the Micro Focus Data File Editor. This copies the archived spool files and merges them into a new, combined archive. It does not change the original archive, so the audit trail remains untouched, but the combined archive allows viewing of all the jobs that have been merged. The merge process is carried out using a JCL job or by using a command line utility.
- A new user exit MFJFAXIT - this user exit allows you to receive notifications when 'file open' events are processed by the JCL engine. A sample exit can be found in the `src\enterpriseserver\exits` sub-directory of your product install directory. You can enable this exit by using the MFJFAXIT environment variable, to point to the exit program.
Mainframe Access

This release provides enhancements in the following areas:

• Browse dataset using IDCAMS dump - when using the MFDAS BROWSE command, it is now possible to view the output of the IDCAMS DUMP command on the specified dataset in hex and printable characters side-by-side.
• Improved JES support for executing jobs and input datasets - it is now possible for MFA Server to interact with JES jobs that are in executing phase, and to list and download input datasets.
• Retrieve binder information for load modules - when executing the MFDAS BINDER command, it is now possible to view the binder information from a load module.
• TSO command server - MFA Server includes a new type of application server to support executing TSO commands as the current user. The address space is spawned as your user id and any valid TSO command can be executed.
• UNIX sub-system (USS) support - MFA Server can now operate on files stored on a USS file system. The available functions are - edit, browse, rename, delete, and copy USS files and directories.

Micro Focus Native Database File Handler

Note: This feature is in Early Adopter Product (EAP) release status.

The Micro Focus Database File Handler (MFDBFH) is a file handler that enables your native CICS and batch enterprise server applications to interact with data files and certain infrastructure files stored within a database.

VSAM files may experience logical and/or physical corruption in the event of a hardware failure. This is due to a single COBOL I-O operation consisting of multiple physical I-O operations. If all the physical I-O operations that make up the COBOL I-O operation are not performed, the file can be left without integrity. In previous releases you could guard against such occurrences with Fileshare and logging, but they required some manual intervention and came with performance cost.

In this release, configuration options have been added that allow the I-O operations to be routed to an RDBMS to take advantage of the availability and performance characteristics of the database. This can be achieved with no changes required to the application. The file will be routed to the SQL database simply by changing the filename prefix to sql://.

Features include:
• CICS and batch Cobol file I-O can now be routed to an RDBMS with only simple configuration changes. No application changes are required.
• Supports all Micro Focus file formats
• Files can be routed to an RDBMS on a file by file basis.
• Utilities are provided to enable data to be moved between disk files and RDBMS.
• Support for PostgreSQL 10.x, Amazon Aurora PostgreSQL, Db2¹, and MS SQL Server (on Windows and Linux Intel)

¹ Db2 support was introduced in the 5.0 Patch Update 2 release
PL/I Support

Enhancements are available in the following features:

- PL/I Run-Time System - support is now available for:
  - Optionally generating Windows "Mini-Dumps" or a Linux coredump off the back of a call to PLIDUMP.
  - Dynamic allocation of datasets using the TITLE option(s).
  - Raising an ERROR condition when a called subroutine raises a COBOL RTS error.
  - FILE variables can have differing DCB when used in differing contexts.
  - STATIC FIXED BIN(31) variable accessed at open within the RECSIZE() attribute of the ENVIRONMENT.

Platform Support

Support is now available for the following additional or updated operating systems:

- SUSE (Power) 11 SP3, 12
- Red Hat (Power) 7.2, 7.3
- Windows Server 2019

For a full list of supported platforms, check HTTPS://SUPPORTLINE.MICROFOCUS.COM/PRODAVAIL.ASPX.
Significant Changes in Behavior or Usage

This section describes significant changes in behavior or usage. These changes could potentially affect the behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem Incident (RPI) number (in parentheses).

- **Common Communications Interface**
- **Communications Server**
- **Compiler**
- **Data Tools**
- **Documentation**
- **Enterprise Server**
- **Enterprise Server Auditing**
- **File Handling**
- **HCO for SQL Server**
- **IMS Support**
- **JCL Support**
- **Mainframe Access**
- **Micro Focus Batch Scheduler Integration**
- **Micro Focus Directory Server**
- **MFCRYPTLIB**
- **PL/I Support**
- **Request Packet Interface API**

### Common Communications Interface

*Back to the list*

- Certificate subject names are now correctly checked against the name the client is attempting to connect to. Certificates registered to "localhost" should now work as expected.
- The default Cipher Suites List now includes @SECLEVEL=0. This indicates that backwards compatibility with old certificates such as MD5 is to be retained. As a result of this change, you need to review your use of the Cipher Suites List and of any old certificates.
- If using Micro Focus Common Client(MFCC) or Micro Focus Communications Server(MFCS) to connect to a non-existent remote host, it was possible to create a connection to a server listening on the same port on the local system. This is no longer possible and a bad address error is reported in the error logs.
- By default, in this and previous releases an SSL/TLS CCI client can trust a server which resides on an IP address that is not an intended connection target. You can now specify the ssl_only_verify_literally option in your CCI.INI file to restrict the certificate check to improve security. See "CCITCP Security Options in the CCI.INI File" in your product Help for more information. When connecting to a non-CCI protocol server, all clients perform strict certificate checking as the new default behavior.

### Communications Server

*Back to the list*

- Passphrases specified in the mf-server.dat file can now contain spaces.
  2832222 (1100976)
- Configuring MFCC when run under MFCS now works as expected.
Compiler

Back to the list

• The Search order has been updated, to allow the Compiler to find Java.

Data Tools

Back to the list

• Accessing a dataset through the Data File Editor now obtains a shared lock on Enterprise Server when you open the file in shared mode.

  3170479 (1115346)

Documentation

Back to the list

• The ANIM Compiler directive has changed its default when compiling from the command line on Windows platforms. The default is now ANIM. (Compiling from the IDE still defaults to ANIM.)

• The validation of server certificates for TLS (also known as SSL) connections has been corrected. This is likely to cause connection failures in cases where previously connections were incorrectly allowed. For example, if Fileshare is secured with TLS, client applications must be configured to use the hostname of the Fileshare server as it appears in the server’s certificate. If the Micro Focus Directory Server is secured with TLS, then MFDS clients, such as the casstart command-line utility, will need to connect to it using a hostname that appears in the certificate MFDS is using. (Note that a certificate can contain multiple hostnames.) Consult your Certification Authority administrator for more information.

  3192497 (1117068)

Enterprise Server

Back to the list

• A number of audit events now contain some additional information.

  3140310 (1112666)

• Previously, the /x option of the CASRDTEX utility had been duplicated to drive XML output. This prevented the export of transactions which was the original meaning of /x. To generate an XML export, you must now specify the option /xm.

  3180233 (1116108)

• casfhsf could hang when processing HSF files that contain records from tasks that ran in different months.

  3177385 (1115884)

• A new system transaction, CRCN, is now available to monitor the state of XA connections for each resource manager (RM) entry defined in the system. CRCN is a replacement for the former XA Reconnect facility that recycled SEPs on connection loss. The XA Reconnect facility was configured by setting the ES_XA_RECONNECT environment variable. CRCN also uses this environment variable, although its usage differs slightly. For more information see your product Help.

  3174272 (1115727)

• On Windows, any casout and cassub messages are displayed on cassub and casout API invocation if the environment variable ES_CAS_API is not set to "ON".

  3160400 (1114458)

• A new environment variable, ES_SNATRC_DIR, is available for configuring the location of the SNA traces written by IMB’s communication manager. To ensure that the SNA trace files are written to a valid directory, ES_SNATRC_DIR must be set before you start the region.
• When defining CICS term in ESMAC, if the terminal definition includes a user ID, Enterprise Server honors the terminal user ID, and you can leave the User ID field blank. Caution: When the terminal definition includes a user ID, this logs you into the terminal without password verification. Use with care!

Enterprise Server Auditing

Back to the list

• Auditing on big-endian platforms now correctly interprets numeric audit data.

File Handling

Back to the list

• RELFORMAT=MF|RM is now enabled for FOLDER and other filename tags.

3164916 (1114803)

• The SORT-CONTROL special register is now supported during a SORT statement.

3159740 (1114389)

• To direct the handling of relative files to a particular file handler (either MF COBOL or RM/COBOL), use the RELFORMAT=MF or RELFORMAT=RM configuration options within the [REL-DEFAULT] tag of the EXTFH.CFG file. (The default is RELFORMAT=MF.)

3157247 (1114149)

• The FORMAT parameter is now correctly ignored when the format is explicitly set in the Include statement. Also, an error is now returned if a numeric item is compared with a quoted value in an Include statement.

3186371 (1116564)

• For MFJSORT, the SORT-EBCDIC instruction is now supported through the PARM parameter of an EXEC statement.

3165343 (1114824)

• When reading continuation lines from SYSIN for MFJSORT, if line 1 breaks at column 71 with a nonblank in column 72, and columns 2-15 of line 2 are blank, DFSORT continues on line 2 with whatever character it finds in column 16 (blank or nonblank).

3159842 (1114565)

HCO for SQL Server

Back to the list

• HCOSS DB2 schema extraction has been updated to use the DB2 system default of EBCDIC SBCS CCSID <value> for DB2 columns in tables with a CCSID value of 0 (zero, CHAR family types). This has been done to appropriately handle the CCSID value for tables created using DB2 version 8 or earlier, and that have been migrated to a newer version of DB2. In addition, HCOSS DDL generation maps Euro collection sequences to the nearest match to a supported SQL Server collation sequence.

3163636 (1114937)

IMS Support

Back to the list

• A performance delay that occurred when rapidly writing checkpoint records to the IMSLOGR file has been corrected by updating the method used to verify the uniqueness of the timestamp in the key.

3131126 (1112901)
• The IMS Support feature has been updated to support checkpoint/restart for output GSAM processing.
  3107543 (1109558)

JCL Support

Back to the list

• If the catalog properties of a data set are updated using MVSCATPB, and the data set is not opened during the JCL step it is assigned to, then the updated catalog properties are not written at the end of step disposition processing.
  3186942 (1116611)

• When security is enabled and a JCL job includes either JOBLIB or STEPLIB entries, the system now checks that the user has READ access to each of the Partition Datasets (PO). If the user does not have the required access, the job abends with a COND CODE of S913.
  3176759 (1115814)

• The DATACLAS and MGMTCLAS attributes are now applied to a DATASET when it is added to the catalog and SMS support is enabled (MF_SMS=ON).
  3174534 (1115630)

• The DSNRLI reason-code value will be hexadecimal 0x00000000 when the return-code is zero. This is a change from the previous value of decimal zero, '0000'.
  3171133 (1115344)

• MFFTP quote handling has been reworked to support IBM behavior. Filenames that contain spaces are now required to be defined within double quotes ("). This change is required to support mainframe hosted files, where single quotes (’) will no longer append the user ID to start of the filename as the first node.
  3168300 (1115058)

• If JES security is enabled, when a JCL job is submitted that uses a PROC or INCLUDE file that is part of a cataloged Partitioned Dataset (PO), READ access for the dataset will be checked, and if the user does not have permission to read the dataset then an error will be reported.
  3166921 (1114955)

• When restarting a job, the COND CODES for steps prior to the restart step will not be evaluated. This is a change in the behavior where previously the values of the COND CODES from the previous run was checked. You can revert to the old behavior by setting the environment variable MFJ_ALL_STEP_CHECK=Y.
  3163358 (1114688)

• The Spool Housekeeping history file, INDEXO, can now support 7-digit job numbering. A conversion utility, MFHKHCOV, is supplied to convert any existing dataset to the new format. Run this utility using the sample JCL job CONVERT.JCL. Once converted, the newly formatted dataset supports both 5- and 7-digit job numbering. If you only use 5-digit job numbering, you do not need to run the conversion. See the 'MVSSPLHK Spool Housekeeping Process' section in the Help for more information.
  3162868 (1114648)

• When performing an IEBCOPY to a partitioned data set (PDS), a check is now made to ensure that the user has DATASET ALTER permission for the PDS.
  3159837 (1114347)

• The DSNRLI functionality for the TERMINATE THREAD call has been improved so that it now calls tx_end and then tx_close for a particular XA resource. A ROLLBACK call will not be issued prior to the tx_close. If an error is returned from the tx_end function, it is reported back to the calling program as return code 12, reason code 0X00F30093.

• Missing and incorrect key values in the MF_JCL_AUDIT event output have been corrected. Also, the audit event code resulting from MF_JCL_AUDIT has also been changed from '2 1' to '5 5' to avoid conflict with the same code being used by other components.
• For RISC-based systems when running JCL jobs, you might need to set COBMAINSTACK to a high value such as 8000000.
• An issue resulting in a Run-Time System error “RTS 119 Name is not unique” when calling ‘setenv’ to dynamically assign a dataset from a COBOL program on a UNIX platform has been resolved. The call to “SETENV” must be made in uppercase characters.

Mainframe Access

Back to the list

• By default, VSAM files whose average LRECL are the same as the maximum LRECL are now treated as Variable when generating a .PRO file. You can override this with the existing /FIXEDVSAM flag, or by specifying a fixed VSAM import type (ESDS-FIXED, KSDS-FIXED, or RRDS-FIXED).
   3181871 (1116216)

• SyncMon2 now uses the Endevor "Source Date" and "Source Time" information to determine if a file has changed since the last synchronization.
   3177475 (1115904)

Micro Focus Batch Scheduler Integration

Back to the list

• When using MFBSI, the message JES000020W (JOB number warning percentage exceeded) is now correctly handled, and no longer results in an invalid MFBSIJCL 208 return-code (JCL error).
   3186963 (1116620)

Micro Focus Directory Server

Back to the list

• The event codes for several MFDS audit points have changed.
• On Windows, by default, the Enterprise Server Administration Web interface can only be contacted using the loopback address (localhost or 127.0.0.1). You can enable remote access to the Web interface by turning off the loopback mode. See “Using the Loopback Address” in your product Help for more information.

MFCRYPTLIB

Back to the list

• Passing an incorrect keyfile passphrase no longer results in receiving an RTS115 error in MFDS.
   3181743 (1116186)

PL/I Support

Back to the list

• A problem with allocation of BASED, CONTROLLED, and AUTOMATIC structures has been corrected. This problem was limited to structures where the last member field was of type BIT. Specifically, the problem only occurred for BASED, CONTROLLED, and AUTOMATIC structures when the last member field is of type BIT, resulting in incorrect code generation for BASED and CONTROLLED storage at the point of allocation (i.e., an ALLOCATE statement), and for AUTOMATIC storage, incorrect stack frame allocation for the declared structure. Naturally, any module affected by this problem needs to be recompiled. To ensure that no problems arise, the user should identify all modules that use a structure or structures where the last member is of type BIT, and recompile those modules. This applies to users who have compiled code with versions of Enterprise Developer earlier than ED 4.0 HF 10. Note: BIT means a bit-string of any length, including BIT(1). It does not apply to BIT ALIGNED.
The Open PL/I compiler now generates a W-Level diagnostic if a constant array dimension or extent is of type CHAR or BIT. This is usually unintended coding.

The macro preprocessor now supports the use of %INSCAN and %XINSCAN.

Previously, if a condition prefix for STRINGRANGE was enabled and a STRINGRANGE condition occurred, it was raised to ERROR after being processed. This no longer occurs.

PLISAXA, PLISAXB, and PLISAXC processing has been enhanced to use ENTRY LIMITED functions and procedures which utilize OPTIONS(BYVALUE).

A problem causing the SQL pre-compiler to hang has been fixed.

SQL is now supported in a PL/I PACKAGE. A SQLCA declaration (usually via include of SQLCA) in a nested block (PROCEDURE or BEGIN) is not allowed. It is allowed only in the outermost block(s) or in a PACKAGE.

Request Packet Interface API

Back to the list

The default behaviour for TLS certificate Common Name (CN) matching has changed for release 5.0. It now requires a strict match on the CN value or any Subject Alternate Name (SAN). For example, 127.0.0.1 and localhost are no longer implicitly equivalent, nor are hostname and its IP address or fully-qualified domain name (FQDN) variants. When starting a region from the Enterprise Server Administration Web interface, a resolved IP address is used for the casstart -m parameter value. A resolved IP address is also used even if a hostname is specified on a command line startup.

To change this behavior and use a resolved hostname value (as determined by the machine TCP configuration, for example, hosts file entries.) set the environment variable MFDS_DNS_RESOLVE=Y. To use an unresolved string literal hostname, for example, a value explicitly passed in via the casstart –m command line parameter, set MFDS_DNS_RESOLVE=N.
Known Issues

Refer to the *Known Issues and Restrictions* topic in the *Product Information* section of your product Help.
Resolved Issues

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem Incident (RPI) number (in parentheses).

- Adis
- Assembler Support
- Codeset Support
- Communications Server
- Data Tools
- Dialog System
- Documentation
- Embedded HTML Pre-Processor
- Enterprise Server
- File Handling
- IBM Language Environment for OS/390 & VM Support
- IMS Support
- JCL Support
- Licensing
- Mainframe Access
- Micro Focus Batch Scheduler Integration
- Micro Focus Common Client
- Micro Focus Directory Server
- Micro Focus Server Administrator
- OpenSSL
- PL/I Support
- Run-Time System
- Setup
- SQL: COBSQL
- SQL: HCO for DB2 LUW
- SQL: HCO for SQL Server
- SQL: MBDT Utilities
- SQL: OpenESQL
- SQL Option for DB2
- Web Service Client
- XML Support

Adis

Back to the list

- ERASE EOL no longer stops Keisen attributes being inherited when enabled by x"AF" function 81.
  3169584 (1115178)
- ACCEPT LINE POSITION data-item, where data item has the JUST clause, now works as expected when the ADISCF pre-clear option is selected.
  3126794 (1111471)
- BLANK SCREEN BACKGROUND-COLOR n, where n > 7, now sets the intensity so that the bright version of the color is used to fill the screen.
  2856949 (1103978)
Assembler Support

Back to the list

• Two Assembler copyfiles mistakenly received the short form of COBOL copyright statements which resulted in the programs of the Assembler ACCT tutorial assembling with errors.

Codeset Support

Back to the list

• JCL jobs executed via the cassub command no longer produce RTS 114 MFTRNSDT errors.
  3173144 (1115497)
• Conversions from ASCII to EBCDIC, with null data, no longer get corrupted.
  3155499 (1114114)

Communications Server

Back to the list

• In some versions of Enterprise Server, a TN3270 conversation would hang if the ATTN key was used. This has been corrected.
  3173146 (1115498)
• The transferring of files via CICS RECEIVE is now working as expected.
  3159602 (1114325)
• Enterprise Server has a service deployment feature, which allows developers and administrators to install new COBOL services (web services and EJBs) into an Enterprise Server instance over the network. This functionality has been enhanced for additional security, with various options for user authentication and authorization. See the product documentation for details.

Enterprise Server

Back to the list

• There is no longer an issue with the order of file retrieval for the list of console logs affecting the calculated maximum log number.
  3192214 (1117023)
• LRECL fields are now displayed correctly in Data File Tools when accessing Enterprise Server hosted data files.
  3186524 (1116586)
• An issue with stopping printer terminals has now been resolved.
  3185553 (1116498)
• MQ Security is now used when using DSNRLI.
  3183523 (1116641)
• A BATCH DLI job executed in a region with at least one XA switch active could abend at the end of a JOB on a SYNCPPOINT PREPARE failure.
  3181636 (1116221)
• In Data Files Tools, the performance of opening a PO dataset that is hosted within Enterprise Server has been improved.
  3178780 (1116293)
• An issue that caused CTG requests using SNT users to be rejected has now been resolved.
  3178729 (1115967)
• An issue with IBM PCOM was resulting in different colors in BMS in RUMBA and PCOMM. To work around this, use the new environment variable ES_3270_REMOVE_NULL_COLOR_ATTRIB. Set ES_3270_REMOVE_NULL_COLOR_ATTRIB to y or Y to prevent the color attribute set to null from being sent in a 3270 flow.

3176924 (1115831)
• The MQ XA switch modules now supports the BATCHONLY option.

3173781 (1115552)
• Previously, xwbauth user exit was not invoked if URIMAP path was greater than 64 characters.

3173349 (1115514)
• When a region was configured to use Extended User Storage, the associated memory was not registered with MFPM. This resulted in issues when using GETMAIN SHARED from a program compiled with the AMODE directive.

3173307 (1115549)
• CICS no longer attempts to map responses for DELETE requests for JSON RESTful services. Previously, this was causing the service to hang or encounter a Run-Time System error in dfheserv.

3172688 (1115459)
• casout will no longer crash when using the /v option and there are more than 256 initiators/batch printers/mprs.

Information for approximately 1300 processes can now be returned. If more than that exist, then casout will return as much as it can and set return-code to 4.

This may be caused by schedulers using the entry point 'casout_getSEPS'. This can be called after using the casout API with the /v option. The signature for this entry point is:

entry 'casout_getSEPS' using lk-casout-area.

lk-casout-area is defined in casbout.cpy but can only hold information for up to 256 processes. If there are more than 256 processes then a call to this entry point will return truncated data (that is, 256 instances) and set return-code to 4.

Since casout /v can now return data for more than 256 processes, a new optional parameter, which is a pointer, has been added to casout_getSEPS:

entry 'casout_getSEPS' using lk-casout-area lk-casout-user-area-ptr.

If there is data for more than 256 processes, then this pointer will be set to the address of the entire block of data.

3171604 (1115376)
• An EXEC CICS RELEASE statement now cancels the LOADED program as expected. Also, the behavior of the statement is aligned with IBM's documentation and programs that are LOADed without HOLD are cancelled/released at the end of a task.

3171175 (1115378)
• Transaction routing requests from the same terminal to an ISC connected region involving a DPL request to an APPC connected SYSTEM now execute successfully.

3170073 (1115270)
• Transactions with a timeout that was running over midnight were timing out prematurely at midnight.

3169194 (1115144)
• CICS files configured to use a catalog entry were subject to a "fix-up" process which resolved alternate indexed dependencies when certain events occurred - for example, SET FILE ENABLE. This has been changed and the fix-up is not systematically driven. Changes applied to the associated catalog entry are no longer picked up automatically. If such changes are made, a fix-up can be requested through the Active FCT view. The file must be closed before the request is made.

3168298 (1115080)
• Event manager exits that are enabled for SEP termination events are now invoked when a SEP, Initiator, MPR or a printer is stopped cleanly (from ESMAC and casout) and not just when they are killed.

3168159 (1115051)

• The cursor position is now correctly identified when using floating maps - a map on top of another map.

3166543 (1114958)

• When starting a CICS Web service application, the start code on ASSIGN was ‘S ’ instead of ‘U ’. Also, a residual EIBCALEN value was left when the application was using channel and containers instead of commarea. These issues have been fixed.

3166323 (1114912)

• If created from a previous run, cas_ipcs.lst and cas_ps.lst will now be deleted at the next region startup.

3165807 (1114872)

• In a heavily loaded Enterprise Server cluster, it was possible for jobs to be dispatched to a printer process instead of to a batch initiator. This would result in the job’s lock being permanently held and prevent further submission of jobs of that name.

3162806 (1116082)

• When Enterprise Server activates an LU62 connection to the mainframe or to another APPC linked system, you can now leave the modename to SPACE. This indicates that the remote side of the APPC connection should use an elected default modename.

3162296 (1114713)

• When the last CICS API of a program invoked by an ECI client fails and this program handles the exception, if this program terminates with a GOBACK rather that an EXEC CICS RETURN, the ECI client does not receive an error anymore.

3161830 (1114584)

• The position of a cursor on a map which size is different from that of the terminal size was incorrect. This has been fixed.

3158745 (1114273)

• In an ESM secure region, when the userid field in a terminal definition was populated, there were issues at region startup or when trying to install the TERMINAL resource.

3158468 (1115137)

• The environment variable ES_DDBG_PORT_RANGE now supports ports that include less than five characters.

3158205 (1114237)

• With ES_XA_NB_RETRIES=-1 specified, Enterprise Server would leak SHM if the connection to the XA RM was lost.

3158011 (1114246)

• CICS Web service response messages larger than 64Kb are now returned correctly.

3155900 (1114044)

• Previously, the transformation of data from COBOL to JSON in CICS Web Services would not collapse whitespace even when CHAR-WHITESPACE=COLLAPSE was used for the generation of the wsbind file.

3154716 (1113953)

• An issue where a region would take too long to start up and eventually fail to start has been resolved.

3153774 (1113875)

• Return codes from file operations on the spool files are now displayed correctly when there is an error.

3153516 (1113882)

• When Data File Editor accesses files managed by an enterprise server region, users now need UPDATE permissions in order to access the file exclusively.
• You can now configure certain fields within the record that is written to a .csv format HSF report. Use the ES_HSF_CFG environment variable to configure the number of Custom, CICS file, TSQ, and TDQ fields in each record. To write custom data to the Custom fields, use the ES_WRITE_CUSTOM_HSF library routine. See the latest SupportLine help for more information on these new features.

• When connecting a TN3270 to an Enterprise Server instance, if the connection was lost, the printer could not be reconnected. Now you can navigate back to ESMAC, then Clients, and stop the printer in order to reconnect it after a loss of the connection.

• Formatting a trace that was captured during the period when the clocks went back an hour will now format the entire trace. Previously, the formatter would exit at the point when the clocks changed.

• An issue with exporting PCT resources has been resolved.

• Enterprise Server, LDAP-based security: The use of Active Directory groups, or other group classes that specify membership using LDAP Distinguished Names, now works correctly when the “user ID attribute” configuration option is also used.

• The Enterprise Server External Security Facility (ESF) now strips leading and trailing whitespace from the user ID and other relevant fields in Verify (user authentication) requests.

• For Enterprise Server LDAP-based security, recent fixes to group processing exposed an issue when multiple LDAP repositories are used and all-groups mode is enabled. This could cause some or all of a user’s group memberships to be disregarded, leading to incorrect denial of access to resources. The problem has been corrected.

• Enterprise Server’s MLDAP ESM Module now supports setting LDAP passwords using salted SHA2-512 hashes. Otherwise known as the SSHA512 LDAP password type.

• In Enterprise Server with LDAP-based security where a security configuration uses two or more LDAP-based Security Managers, and use-all-groups mode and group federation are enabled, in some cases group membership was not processed correctly. Messages about “configured number of groups exceeded” could be logged. This issue has been resolved.

• With certain Enterprise Server security configurations, the Data File Editor could display a “signon failed” error when attempting to edit a dataset. This has now been fixed.

• The cache feature of the Enterprise Server External Security Facility now ignores some metadata when comparing requests with cache entries. This is configurable. By default, the subsystem (CICS, JES, etc.) and facility (terminal name, if any) are ignored. No ESM Modules supplied with the product use that information in making security decisions. This significantly improves the cache hit rate and system performance in some environments. See “Enabling and Configuring Caching” in the product documentation for more information.

• When using LDAP-based security for Enterprise Server with an OpenLDAP-based provider (client) library, the “connect timeout” setting now works correctly.

• When using Enterprise Server with LDAP-based security, it is now possible to specify an LDAP attribute for user-group objects which specifies an alternative name for the group using the group short name.
attribute. See "MLDAP ESM Module Custom Configuration Information" in your product Help for more information.

3171437 (1115364)
• Enterprise Server LDAP-based external security no longer experiences a rare failure ("error code 7") when verifying a user with advanced group processing options enabled.

3168197 (1115048)
• LDAP-based security for Enterprise Server could produce MD5 password hashes (using the "mode=bind" and "password type=MD5" configuration option; note this is rarely used) which did not use the canonical Base64 encoding. Some LDAP servers did not recognize these password verifiers, resulting in sign-on failures after users changed their passwords. This has been fixed.

3162441 (1114843)
• In Enterprise Server, the MLDAP ESM Module now supports the short-to-long username mapping option of the External Security Facility (ESF).

3160464 (1114394)
• Enterprise Server now includes LDIF (LDAP Data Interchange Format) files suitable for configuring LDAP-based security using the OpenLDAP server.

3147666 (1113475)
• Enterprise Server's optional LDAP-based security (External Security Facility with MLDAP ESM Module) now supports the Microsoft "group" LDAP class, as used by Active Directory and AD/LDS. Consult the online product Help or ask Micro Focus Customer Care for additional information.

3109881 (1110084)
• On Linux and UNIX platforms, the MLDAP ESM module in Enterprise Server LDAP-based security, by default searches for an appropriate LDAP provider (client shared object) in the default locations used by the OS vendor's preferred LDAP client package. It is also no longer necessary to specify the "provider" option in a Security Manager configuration.

• After changes to RPI 632930, a literal with spaces at the end caused a compilation error when used in SEND MAP. This is now fixed.

3187511 (1116671)
• An issue that caused BMS Paging to terminate when no PFKeys were defined in the SIT has been fixed.

3184331 (1116708)
• CICS Web Services requester applications were not always sending the correct value for the SOAPAction header.

3182512 (1116255)
• An issue with the CASA_ECI function was causing a run-time error on calls to modules loaded via CICS LOAD HOLD. This has been fixed.

3177527 (1116614)
• INQUIRE TASK, SET TASK FORCEPURGE and SET TASK KILL now work when passed a task ID that corresponds to a task running in a transient SEP.

3176467 (1115802)
• EXEC CICS ASSIGN PRINSYSID now returns the system identifier (SYSID) of the principal facility on a DTP exchange.

3176355 (1115959)
• EIBTASKN now conforms to IBM CICS with a maximum value of 99999. When reached, the task number rolls over to a value greater than zero.

3168772 (1115148)
• An issue that sometimes caused an infinite loop in user prologue code when multiple CALLs were made to the same CICS compiled program has been corrected.
• UTF-8 special characters used in languages such as Swedish and German are now supported for dataset names and in FCT resources.

• An issue that caused a long-running task that issued an EXEC CICS SYNCPOINT to throw a duplicate XID error has been fixed.

• Programs containing CICS RECEIVE INTO / RECEIVE MAP in a DBCS environment and compiled to ASCII produced an erroneous @ symbol when data sent as part of a MAP was truncated using the Delete key. This has been fixed.

• An issue in identifying the first available open port for regions containing multiple TCPIPSERVICE definitions that use the same port has been resolved. Enterprise Server now searches all ports that match the port number provided by the request, and uses the first available open port. If an error occurs, a message is returned to the client.

• An issue with creating FCT entries with 'Use Catalog' has now been fixed.

• The following options have been implemented for SET TERMINAL:

  PURGETYPE(PURGE) / PURGE
  PURGETYPE(FORCEPURGE) / FORCEPURGE
  PURGETYPE(KILL) / KILL
  TERMSTATUS(RELEASED) / RELEASED

• Messages containing %s caused a CASCD error. This has been fixed.

• Programs that contained RECEIVE INTO followed by a RECEIVE MAP using FROM and INTO options caused errors when compiled to ASCII. This has been fixed.

• The attention key was lost when using CSPG, this has now been fixed. When defining the BMS PAGING KEYS, you need to use the command first before the value for the key. For example, if the retrieve command is P/ then the PFK1 should be set to P/N (N for Next), PFK2 P/P (P for Previous) and so on.

• casrdtup now supports all valid characters in the TDQ Name.

• XWBAUTH is now invoked on CICS INVOKE SERVICE when the associated URIMAP is defined with AUTHENTICATE(BASIC). Important: With this update, all applications that use WEB CONVERSE or WEB SEND SESSTOKEN explicitly with the AUTHENTICATE, BASICAUTH, or NONE options, and that do not use a URIMAP that specifies the AUTHENTICATE attribute, must be recompiled. (This does not affect applications that use a URIMAP that specifies the AUTHENTICATE attribute.)

• Support for the client WEB SEND command has been updated to include support for the BASICAUTH option.

• A copybook required to build the printer exit was missing. This has now been fixed.
• The INQUIRE TSQUEUE and TSQNAME now read direct for "non-browse" INQUIRE requests. Support for numitems has also been enabled.

3156161 (1114077)

• To fix an issue with the maximum length for a query string being too small, it has been increased from 255 to 1024.

3155607 (1114025)

• The DEFINE TRANSACTION topic has been updated to correct the descriptions for the DTimout and Runaway recovery keywords.

3132186 (1111913)

• An issue which resulted in the DELETE and DETAILS button staying disabled in the casrdo45 page has now been fixed.

3181230 (1116351)

• Previously, when viewing cataloged datasets or Spool files in ESMAC, it was not possible to view any lines beyond line 99,999. Now the limit for the START field in ESMAC has been increased to hold any number up to 99,999,999.

3181032 (1116152)

• An RTS error 153 occurred when more than 6400 PCT entries were displayed in ESMAC. This has been fixed.

3167388 (1115007)

• With some specific LDAP configurations there were problems with accessing datasets from ESMAC where the configuration should have allowed access. This has now been fixed.

3167364 (1114989)

• The response time for catalog searches using 44 character strings in ESMAC has been improved.

3162969 (1114933)

• Remove locks is now enabled if the user has authorization in ESMAC.

3157534 (1114372)

• Deprecation of set-cookie meta tag in newer versions of some browsers such as Chrome or Microsoft Edge caused issues with the cookies used by ESMAC. This has now been resolved.

3154175 (1113973)

• The new JCL-specific environment variable ES_JES_SORT_SPOOL_BY specifies which column is initially used to sort the spool records in casrdo41: ES_JES_SORT_SPOOL_BY=JOBNAME|SUBDATE|JOBUSER

Note: If any other value is specified, then the spool records are sorted based on the JOBNUMBER (JOBID).

3152682 (1113846)

• The esfadmin command-line utility now allows command-line and option-file parameters of any length, up to the maximum command-line length of 8192 bytes. All esfadmin parameters can appear in the option file except -o (which specifies the name of the option file).

2881372 (1107519)

• When using Enterprise Server with LDAP-based security, with two or more LDAP External Security Managers, with the use-all-groups mode enabled, and with federation either enabled or in compatibility mode (the default), it is no longer necessary to have a definition for each user in each LDAP ESM. Specifically, once one LDAP ESM has identified the user, subsequent ESMs (those specified later in the list of security managers) can specify additional groups for that user without having to define the user again. For example, a security configuration specifies two LDAP security managers, LDAP-A and LDAP-B. LDAP-A contains only user records. LDAP-B contains only group records and resource access rule records. All-groups mode and federation are enabled. This configuration now works as expected.

2545079 (1081762)
- `xa_open` in the switch module now returns the correct return-code.
  3171133 (1115386)
- The path of ESDB2XA switch module is not required in the environment variable `LD_LIBRARY_PATH` when the application is compiled with XAID option and the dynamic switch module is used.
  3164301 (1114734)
- Within the DB2 LUW switch module, issues associated with ESLOGGING `xa_open` string parameter have been addressed, and better handling of impersonated userid when using USERP has been provided.
  3156639 (1114209)

**Data Tools**

*Back to the list*

- The cursor is now visible in the free-text editing pane when the pane has focus whether it is in Shared or Exclusive mode. The cursor position will start counting from column 1, rather than column 0 as well.
  3154869 (1113954)
- On systems with a Japanese Locale, the Data File Tools utility no longer includes the phrase "Technical Preview" in its title.
- The IMS DB Editor's handling of segment layouts that contain hyphens has been improved.
  3156235 (1114112)
- You can now merge your archived spool files to a central location, using a JCL job or by using a command line utility. Once merged, they can easily be viewed together using the Micro Focus Data File Editor.
  3154771 (1113949)

**Dialog System**

*Back to the list*

- An issue which prevented character mode Dialog System from recognizing ctrl-J and other key combinations has been resolved.
  3189921 (1116908)

**Documentation**

*Back to the list*

- Result precision has been added to the following built-in functions topics in the LRM: INDEX, MAXLENGTH, SEARCH, SEARCHR, VERIFY, VERIFYR.
  3183332 (1116336)
- The product help now includes a clarification in the topic "To run a native COBOL application from a network server". It states that you must remove any individual copies of run-time system modules (for example, cblrtsm.dll) that might have been copied into your application’s working directory. This is to avoid issues with running the application such as "245 no valid licenses found" as the run-time system is not loading from the expected location, or where the copied run-time modules are from other versions of the product versions. Removing such modules ensures that any run-time system modules are only loaded from the Enterprise Server instance installed on the server.
  3176098 (1116309)
- The Software Requirement on UNIX topic in the docs and in the Release Notes now specifies that SafeNet licensing requires that you have glibc-locale-32bit library installed on 64-bit machines.
  3167672 (1115010)
Depending on the environment, you need to export (UNIX) or set (Windows) environment variables in a script. See “To specify environment variables for an application” for more information.

The documentation now includes the instruction that when deploying a subset of Run-time System files, you must include run.cfg in a sub-directory named ‘etc’.

When performing a sort that specifies more than one input file, you cannot specify one of those same files as the output file unless it is the first input file specified.

Details of how to use ILBOABN0 have been added to the documentation.

The documentation (in the COBOL Language Reference) has been updated to clarify the use of the OPTIONAL keyword, and the use of (managed) optional parameters within the Procedure Division Header.

The National Locale Support (NLS) Library Routines section of the documentation now contains all available NLS routines.

The Significant Changes in Behavior section of the documentation now includes the default change for FASTINIT. (This change occurred in version 3.0, as stated in the release notes on release.)

The documentation has been improved for the CBL_LOCATE_FILE library routine concerning the use of space- and null-terminated strings.

The Rebuild syntax differs between UNIX and Windows platforms. For any of the Rebuild options, UNIX platforms use a hyphen (-) prefix before the letter, and Windows platforms use a forward-slash (/) before the letter.

The recommended method of high availability for VSAM files in Enterprise Server is to use standalone Fileshare. The documentation has been changed to reflect this.

The documentation has been updated to reflect that ‘DEFAULT’ is a reserved word when running under an ENTCOBOL dialect.

In the documentation, the code example given in the ‘Thread-specific Data Handling Routines’ topic now compiles cleanly.

The called program search order, as documented in the ‘Backward Compatibility’ section of the documentation, has been corrected for Windows platforms.

The parameter definition for OOCTRL”+/W” has been clarified in the documentation.

The documentation now contains a topic - Using a File Handler in JVM COBOL - detailing how to manually configure the File Handler that a JVM COBOL project uses.

A link to the IBM documentation added to the ‘DSNRRI Functions used for RRSAF’ topic - this is to enable you to locate full details on required parameters, and to give examples of its use.

The documentation now states that the section heading when adding environment variables through the Enterprise Server UI is case sensitive.

The CICS Support section of the documentation, under Mainframe Programming, now contains a sample XWBAUTH program that can be adapted when users create their own user exits.

The documentation explaining the scope for the HOST-NUMCOMPARE directive has been simplified.

The "To specify the location of application files" topic has been updated to clarify the location of IMS copybooks.
• Documentation for all Java API classes is now provided in HTML format and contained in an archive file located by default in the %ProgramFiles(x86)\Micro Focus\<product name>\javaee-ccl\docs directory. See the Java API Classes topic in your product documentation for details.

3109273 (1109725)

• Documentation for all Java API classes is now provided in HTML format and contained in an archive file located by default in the %ProgramFiles(x86)\Micro Focus\<product name>\javaee-ccl\docs directory. See the Java API Classes topic in your product documentation for details.

3109271 (1109724)

• The documentation on setting up an SMS data class has been improved, which now includes a working JCL sample.
• The sample code listed in the CBL_DIR_SCAN_READ documentation has been formatted to enable you to copy and paste the code, ready for compilation.
• The sample in the documentation on ‘Using FHRedir and an allocation override rule’ has been corrected to show the spool filenames in their correct case (upper case).
• The documentation now includes a definition for the system abend code S913 (which is “Security Violation - the user is not permitted to access the resource”).

Embedded HTML Pre-Processor

Back to the list

• An issue that caused the embedded HTML preprocessor to display incorrect banner information has been corrected.

3160255 (1114437)

File Handling

Back to the list

• Warning messages when checking disk space for Fileshare advanced logging are now only displayed when necessary. Previously, a disk space warning was given even if sufficient space was available.

3174510 (1116078)

• A Fileshare server shutdown no longer leaves files opened or users remaining logged on.

2837526 (1108076)

• CFLE updating large record no longer results in an RTS252 error with the HA-VSAM configuration.

3167973 (1115057)

• You will no longer receive an RTS114 error when a failing primary node is restarted and attempts to re-join the HA group (as a standby node), as long as it closed all files successfully before the failure.

3159872 (1114360)

• Rollback recovery will no longer hang when processing a bad log entry during a scan of the transaction log file.

3168055 (1115049)

• A new MFJSORT option allows input LSEQ files to be treated as FB through setting the environment variable MFJSLSEQFB=ON.

3190089 (1116876)

• SORT operations no longer compare field data that is outside of the current record length.

3187044 (1116633)

• MFJSORT now ignores the RECORD TYPE value if the SORTIN dataset is non-VSAM.

3163293 (1114669)
• During a SORT, the SUM statement now correctly handles 8-bytes BI fields.
  3161349 (1114540)
• An internal SORT program no longer returns a COBRT252 error for cataloged files when being compiled with AMODE="31" and dialect="entcobol".
  3161100 (1114586)
• SORT no longer produces an RTS114 error when both outfut and sortout datasets are not defined.
  3154290 (1113901)
• MFJSORT now correctly honors MFJ_INPUTDS_ERROR=N on missing physical concatenated datasets.
  3153313 (1113826)
• MFJSORT OUTREC now applies the correct length for EDIT patterns.
  3145526 (1113484)

**IBM Language Environment for OS/390 & VM Support**

*Back to the list*

• Calling CEEGTST routine in LE support under JVM COBOL could sometimes result in an RT198 error. This is now resolved.
  3193016 (1117082)
• An issue resulting in an RTS 173 error when using LE370.jar and 'Dynamic calls' has been resolved.

**IMS Support**

*Back to the list*

• The correction to SI 2847064 (RPI 1103584) caused the DBDGEN directive SXRBAFORMAT(2) to behave as SXRBAFORMAT(0). SXRBAFORMAT(1) was unaffected.
  3186315 (1116562)
• An issue that caused enforcement of segment delete rules when deleting a virtual logical child (VLC) segment via an ACCESS=LOGICAL DB view has been fixed.
  3183252 (1116497)
• An issue that caused a GE error has been fixed. With this fix, the position on a database that supports POS=M or multiple hierarchical paths is flushed only when the current position on that segment is different than the previous position, or when the segment being processed is the lowest-level segment in a GU/GHU/ISRT call.
  3167069 (1114975)
• The PCB segment level after an unsuccessful GNP call (status GE) did not always match that of IBM IMS.
  3156252 (1114067)
• An issue that caused multiple hierarchical database fields to show in incorrect positions on the screen when the PCB for the database specified POS=M has been fixed.
  3155761 (1114070)
• An issue that sometimes occurred when a GN or GHN that was either completely or partially unsuccessful caused the return of an incorrect segment level in the PCB feedback, depending on call SSAs and prior DB position. This has been fixed.
  3153595 (1113843)
• IMS BTS tracing was not available for CICS. This is now supported via the ES_SSTM_CICS environment variable.
  3152981 (1113795)
• An issue when using a virtual logical child (VLC) with multiple defined sequence fields sometimes produced incorrect results when using those fields in a segment search argument (SSA) boolean operation. This has been fixed.

3151898 (1113783)

• In some circumstances, a DX status code (DLET rule violation) might have been issued in error or not issued when it should have been. This has been corrected.

3149186 (1113582)

• A new IMS-specific environment variable, ES_IMS_OPEN_TIMEOUT, has been added to define the wait period in seconds during which IMS retries the opening of a database file that is in use by another task. Default is 30 seconds.

3105263 (1109307)

• The EQU macro is now accepted for PFK values. If the EQU value is a literal spanning more than one line, then it must be coded such that the value goes all the way into column 71 with a continuation character in column 72.

3184467 (1116451)

• An issue with MFS map output caused storage violations in CASTMC. The size of the output buffer has been increased to correct this problem.

3180502 (1116197)

• An issue that caused incorrect formatting on print output with multiple DPAGES has been fixed.

3178841 (1116049)

• When compiling the MFS source for EBCDIC, some conditional literal values were erroneously stored in the generated control block as ASCII, causing a print output error. This has been fixed; however, previously generate MFS must be regenerated to pick it up.

3178841 (1116848)

• An issue that caused screen values to be lost when moving NULL to output fields has been fixed; however, to restore the screen values, you must regenerate the MFS.

3174377 (1115708)

• An issue that caused a loss of input data when the PF5 key was pressed repeatedly and rapidly, or when the keyboard was locked, for an MFS screen set to clear all unprotected screen fields upon output. This has been fixed.

3157814 (1114455)

• An issue that prevented dynamic debugging from working correctly when switching to a second IMS transaction has been fixed.

3180027 (1116094)

• When XA was enabled, an IMS BMP that issued a STOP RUN instead of a GOBACK caused unpredictable errors depending on the XA resources defined. This has been corrected.

3165313 (1114838)

• IMS Connect has been updated to support the IRM header to be in either EBCDIC or ASCII. In addition, system messages returned in the response are now in EBCDIC when the input IRM header is EBCDIC or the header's IRM_F5 "translation done by client" bit is set (x'40'), indicating the client expects the response to be EBCDIC. This is consistent with non-system output messages, which are in EBCDIC when this bit is set.

3179210 (1116368)

• When trying to print during a TN3270 session, the terminal could hang waiting for a response. This no longer occurs.

3177584 (1116002)

• A program-to-program message-switch to a non-response-mode transaction sometimes caused a DFS2082 message to appear erroneously. This has been fixed.
Resolved Issues

3172148 (1115425)
• A message inserted by a response-mode transaction to an express PCB sometimes causes a DFS2082 message to appear erroneously. This has been fixed.

3168150 (1115053)
• A limitation with MQ Writer prevented it from automatically reconnecting to MQ after losing the connection. MQ Writer has been updated to automatically reconnect to MQ if it should lose the connection.

3164352 (1114745)
• An issue that occasionally caused CASTMC RTS200 (ID: 9c12) errors has been fixed.

3159168 (1114303)
• To correct An issue with routing MQ-IMS Bridge output messages, these messages can now be routed to a reply queue based on LTERM, as configured via the new OTMA destination-descriptors environment variable (ES_IMS_OTMA_DEST).

3154367 (1113959)
• IMS support has been updated to include program-to-program message switches from OTMA-submitted transactions.

3153840 (1113862)
• An issue that caused a GN call to fail on a message segment that used an alternative PCB when the segment was not the first in the message, and its insert was immediately preceded by an insert to a different PCB, has been fixed.

3153486 (1113857)
• Two new Enterprise Server environment variables, ES_IMS_SINGLE and ES_IMS_LTERM_PREFIX, have been added that enable you to configure support for multiple sign-ons by a single user across multiple LUs.

3146936 (1113313)
• New IMS print exit functionality allows data destined for a printer to be redirected to the DFSPRINT exit routine prior to any printing.

3140423 (1112727)
• Enterprise Developer now increments the task number for "Wait for Input" transactions where the input message is not the MPP initial schedule message and not a message returned immediately for a COMMIT/GU request.
• An intermittent issue that could result in receiving an incorrect output, RTS 114 error messages and TM message queue corruptions has been resolved.

JCL Support

Back to the list

• mfjctlbp has been enhanced to include the return code, reason code and the return type from a call to an executable.

3190808 (1116938)
• An issue that prevented jobs from being started when an initiator was available has been fixed.

3184852 (1116450)
• The incorrect removal of commas between parameters passed to the REXX interpreter, introduced in release 4.0 Patch Update 5, has been corrected.

3184475 (1116418)
• An issue that prevented the MSGCLASS JOB CLASS, and the setting of ES_JESYSMSG_OUTPUT and restrictions, from being honored for SSTM jobs has been fixed.

3183255 (1116438)
• The "Job Completed" date and time for SSTM jobs is now set when the a job is marked as completed.
  3183255 (1116764)
• MFFTP APPEND processing has been enhanced to accept the abbreviations AP and APPE, and to
  correctly process quoted dataset names.
  3182125 (1116215)
• The next generation indexing for a relative generation following a sweep delete of GDG generations has
  been improved, to be more consistent with mainframe behavior.
  3181663 (1116195)
• An issue that prevented auditing in 64-bit COBOL processes has been corrected.
  3180251 (1116090)
• Performance in retrieving the next JCL job to run has been improved.
  3179792 (1116151)
• You no longer experience performance issues with Data File Tools when the editor is displaying PO
  entries hosted in Enterprise Server.
  3178780 (1116139)
• When opening a data set from the Data File Editor, you can now filter the catalog contents further by
  using the 'Disable Additional Qualifiers' check box. This is the same option as is available in ESMAC; it
  emulates the effect of disabling the 'Include Additional Qualifiers' option on the mainframe.
  3178780 (1115991)
• Within an MFFTP CD command, directories contained within single quotes will no longer have double
  quotes added around the single quotes.
  3178420 (1115998)
• The incorrect step COND CODE of zero when a PL/I program abends because the OUTLIM value has
  been exceeded, has been corrected, and will now be correctly reported as S722.
  3177778 (1115902)
• An error was incorrectly being reported when a symbolic parameter substitution split over multiple lines.
  3177166 (1115863)
• An error when trying to rename a data set where its location was identified using an environment
  variable in the allocation override, coupled with ES_ALLOC_EXPAND=N, has been corrected. The
  environment variable is now resolved to the correct physical location.
  3176747 (1115832)
• An error when using an in-stream SYSIN dataset in IBEDG, stored in a user catalog, has been
  corrected.
  3175437 (1115735)
• A lock on a dataset is now removed correctly when using mvscatpb.
  3174350 (1115610)
• You no longer received an "Index out of bounds" error message when exporting a catalog using
  MFCATXML.
  3173762 (1115550)
• If a job abends because it timed out (S322 abend code), any SYSOUT files from the job that were
  'active' will now be moved to either the OUTPUT or the OUTPUT HOLD queue.
  3173743 (1115562)
• In MFFTP, the data conversion module name, specified by MBDATACONN or SBDATACONN, is now
  parsed correctly and the module called to perform the data translation.
  3173596 (1115776)
• Program parameters changed by the user exit, MFJUXIT, are now applied correctly. An invalid
  parameter passed to IKJEFT01 is reported as such, but does not set a COND CODE of 12. Commands
not found by IKJEFT01 do not set a COND CODE or stop processing. Commands not found by IKJEFT1A or IKJEFT1B are reported, give a COND CODE of 12, and stop further processing.

3173270 (1115511)
- Assembler run-time support for SSTM under Enterprise Server is now available. The Assembler run-time now performs a check for Enterprise Server run-time environments with JCL enabled or with SSTM enabled for IMS and CICS online environments. If found, Assembler attempts to merge its own MVS control block emulation with the MVS control block emulation being done in the JCL component.

3172585 (1115455)
- If DSNRLI makes a TX call that does not return the expected value, the return code is reported in a message to the job log and the return code from DSNRLI is 8. The reason code reflects where the issue occurred.

3171133 (1115345)
- Following a TERMINATE IDENTIFY call, DSNRLI now return a return code 4, with a reason ERR-NOT-IDENTIFIED on a call for the same XA resource until a new IDENTIFY call is made.

3171131 (1115360)
- When an SMS DATACLAS is used, the relevant values are now used from the DATACLAS when a new GDS is created unless explicitly defined otherwise.

3170401 (1115293)
- An issue with the spool housekeeping utility (MVSSPLHK), which failed to find some data sets when ES_ALLOC_EXPAND=N was configured, has been resolved.

3169705 (1115264)
- When a the value associated with a PARM within a JCL job is quoted and spans multiple lines, the white space at the end of the lines is now correctly retained.

3166752 (1114968)
- SYSPRINT DD DUMMY is now supported within an IEBPTPCH step.

3166633 (1114931)
- The spool file ()-create-date and ()-create-time fields are now correctly populated in the printer exit interface.

3165857 (1114871)
- The console log message MVSER0995U now reports the file status code.

3164710 (1114774)
- The 'mfpubcat.inc' PL/I file now contains the same declarations as its equivalent COBOL file 'mfpubcat.cpy'.

3164527 (1114777)
- MFCATXML now returns both any records of datasets from user catalogs as well as the main system catalog.

3162870 (1114667)
- An error when deleting a job on the Input queue, which resulted in a SYSZJOBD lock being left, has been corrected.

3162806 (1115022)
- The IDCAMS ALTER GDG processing now includes support for the EMPTY|NOEMPTY, SCRATCH|NOSCRATCH and LIMIT parameters.

3161965 (1114592)
- If the current highest bias of a GDG is removed outside of a JCL job, for example via the ESMAC catalog view or the public catalog API, the high bias value of the GDG model is recalculated to reflect the remaining biases.

3161796 (1114520)
• SHAREOPTIONS settings in a MODEL cluster are now applied correctly to a newly-defined CLUSTER.
  3161763 (1114517)
• An RTS114 error, reported when closing down a region containing an allocation override file that
  contains an unsupported condition, has been rectified.
  3161604 (1114655)
• The missing PL/I include file, mfpubspl.inc, has been added to the product.
  3161446 (1114489)
• A failure to create archive catalog records when using spool housekeeping with a user catalog has been
  corrected.
  3161437 (1114485)
• An issue translating the received FTP file when the working files where under the control of Fileshare
  has been corrected.
  3160811 (1114484)
• A performance improvement in the job recovery processing has been made by removing some
  additional unrequired reading of spool job records.
  3156375 (1114147)
• MFFTP now encloses anything that follows a 'cd' command with double quotes, unless the quotes are
  already present.
  3154403 (1113925)
• If the association of an XA Switch module with a unit of work fails, DSNRLI now reports appropriate
  error codes for functions that require the association.
  3151780 (1113682)
• A security PHYSFILE check is now only performed when the physical file or directory does not exist.
  3150380 (1114031)
• A new option for MF_UCC11 processing is now available. Use MF_UCC11_DYNCLEAN=N to prevent
  the cleaning of dynamically allocated datasets when restarting a job.
  3149990 (1113815)
• Allocation Overrides can be applied to the new path and name of a physical dataset when the IDCAMS
  ALTER NEWNAME command is used and the environment variable MF_PCRENAME_LAX=D is set.
  3149083 (1113510)
• An issue that occurred when submitting JCL jobs using the CICS WRITE API and the Internal Reader
  has been fixed. The environment variable ES_CAS_API=ON is now set automatically in the process
  that submits the job.
  3148986 (1114840)
• A 'Catalog Duplicate Exists' error, reported when creating a new GDG bias and the GDG Model resides
  in a user catalog, has been corrected.
  3148698 (1113498)
• A fault, reported as 'not found' or 'attribute mismatch', when using ES_ALLOC_EXPAND=N and
  opening a VSAM file, has been corrected.
  3144287 (1113057)
• An issue with tab characters in the allocation override configuration file, when the EXTFH configuration
  setting EXPANDTAB=OFF is set, has been corrected.
  2876194 (1106812)
• When a job with a RESTART parameter on the JOB CARD is first submitted, the SYSOUT files will now
  have names based on the job submission time rather than the job run time. When a job is restarted, the
  new SYSOUT files will have names based on the restart time.
  2856323 (1108461)
• A catalog error when deleting a dataset from a directory that is also the target of a Dynamic PDS has been fixed.
• VSAM SHAREOPTIONS options are now passed correctly when getting and setting VSAM records using the public Catalog API, MVSCATPB.
• A failure when reading the VSAM file header when a file was under the control of Fileshare has been fixed.
• Removing a lock on a dataset when using mvscatpb now works.
• An issue with multiple VSE $LST entries, where previous entries were being overwritten, has now been corrected.  

3169047 (1115308)

 Licensing

 Back to the list
• cesadmintool.sh now searches for "version" string in the Java version and ignores any additional output that might appear.

3185425 (1116559)
• In Docker environments, the license administration program, MFLicenseAdmin, now copes with longer-than-usual license strings. These occur with longer pieces of customer information embedded in the license.

3174371 (1115634)
• There is no longer an entry in the Uninstall column for licenses installed on remote machines.

3131570 (1112101)

 Mainframe Access

 Back to the list
• MFDAS now supports importing IMS and DB2 types to the local catalog.

3184718 (1116546)
• The /CATLOG option on MFDAS commands is no longer ignored.

3131397 (1111830)
• MFDAS now correctly respects connection information specified by the caller.
• The MFDAS command line now supports submitting QSAM or PDS members remotely.
• MFA no longer fails to return information about data sets on extended addressing volumes (EAVs).

3173574 (1115901)
• Expanding a job in JES Explorer to view the SYSOUT data sets now also displays the input data sets. This corresponds to the SDSF INPUT ON command.

3168184 (1115117)
• MFA no longer abends if the AUDIT feature is enabled. The AUDITRPT utility has been fixed.

3160243 (1114378)
• MFA no longer shuts itself down after session time-out because of a system wait.

3158778 (1114316)
• If an external job gets an enqueue on an Endevor resource while MFA is using it, then MFA no longer receives multiple abends and halts when the resource is released.

3149517 (1113490)
• When an application server job name sequence number reaches the maximum specified number for that group, the sequence number will wrap to 1.

2860257 (1104402)
• SyncMon2 will now display characters correctly when the console output is redirected to a file.
  3184737 (1116484)
• The MFA server no longer omits the member separator record when performing a bulk member import
  for Endevor.
  3161685 (1114507)
• SyncMon2 GUI has been redesigned to make it easier to understand when adding different types of
  sync items. For example, it is now clearer what information is needed when syncing against Endevor.
  3147936 (1113476)
• ALLOW_REGEX is now optional for all sync types.
  3147936 (1113422)
• SyncMon2 will now correctly accept EXT= or EXTENSION= for specifying a file extension to be used for
  the sync.
  3183101 (1116324)
• When SyncMon2 was unable to contact MFA Server it would try and print an error message and crash.
  This has been fixed and will now correctly display the error message.
  3174011 (1115779)
• MFA Drag and Drop now supports passphrases of up to 100 characters.

Micro Focus Batch Scheduler Integration

Back to the list
• When MFBSI basic substitution is used, any characters (not just numerics) in cols 73-80 are now
  ignored.
  3189187 (1116795)
• When using MFBSI Basic or Control-M substitution, the submitted resulting JCL file was sometimes
  automatically deleted when “Keep-Subst-JCL=NO” was set via an environment variable or in mfbsi.cfg.
  This has been fixed.
  3188547 (1116737)
• When a Control-M %%INCLIB statement using an %%IF/%%ELSE sequence is used in JCL in-stream
  data, invalid //*CTM INCLIB is no more outputted in the JCL data.
  3183202 (1116321)
• The Control-M variable %%JOBNAME takes its value from the JOBname found on the JOB card, and
  will now honor variable substitution. In the following example, %%JOBNAME will be resolved to
  “TESTQA”.
    // * %SET %ENV=QA
    //TEST%%ENV JOB (101,'ES JCLS'),CLASS=A,
    // MSGCLASS=H,COND=(4,LT)
  3171321 (1115408)
• When using CASAPI, JobNumber for JOBnnnnnnn.log is no longer truncated (to 5 chars).
  3153191 (1113827)
• When the Control-M autoEdit facility is used, the character "~" (tilde) is no longer replaced by a space.
  3150693 (1113624)

Micro Focus Common Client

Back to the list
• Applications which use the Micro Focus Common Client (MFCC), such as the Interface Mapping Toolkit
  (when deploying a COBOL web service or EJB to Enterprise Server), can now specify credentials when
binding to the Micro Focus Directory Server. This provides additional security. If credentials are not configured, MFCC will use an anonymous bind, as it did in earlier product versions. Credentials are specified using the mf-client.dat configuration file.

Micro Focus Directory Server

Back to the list

- The Enterprise Server Administration Web UI will only display user session details if the logged in user is authorized.
  3190235 (1116886)
- Additional Enterprise Server Administration Web UI server-side checks were added to guard against non-editable field value changes for started Enterprise Server instances and active security configurations.
  3185626 (1116719)
- Establishing a connection to a TLS-enabled MFDS process if non-default (non-DemoCA) certificates were used now works as expected.
  3174276 (1115675)
- The MFDS journal data format has been enhanced to be platform and bitism independent.
  3169565 (1115249)
- Improved validation of data input to Enterprise Server Administration Web UI.
  3163386 (1114693)
- Adding or editing TCP listener-requested endpoint values using the Enterprise Server Administration web UI so that a port clash may occur now gives a warning rather than being disallowed and treated as a user input error.
- If the Enterprise Server Administration Web UI is hosted in a Docker container, the displayed hyperlinks to reach the Micro Focus Communications Process web pages can now be configured to use an address which is valid outside the container.
- URLs to SSL-enabled MFCS Control Channel addresses displayed in the Enterprise Server Administration HTML UI now use an https prefix.
- A new field, "Server CA Root Certificate", is available in the Communications Process Control Channel page (id: c400). The value specified here is used unless the MFDS_server_CAROOT environment variable was specified as it takes precedence. You must specify the server CA root certificate if the Communications Process Control Channel is SSL/TLS-enabled and if communications with the MFDS process are required such as to respond to keepalive and any other administration control requests.
- Enterprise Server Administration Web UI would sometimes display the successful logon splash screen instead of a logon error message.
- The MFDS process could terminate when copying the definition of an Enterprise Server instance if it contained a very long description text.
- Trying to view or edit the properties of a Security Manager that is not in the Directory Server Security Manager list now results in receiving an appropriate warning message instead of an HTTP 404 error.
- MFDS now saves any changes made to the Communications Process immediately instead of at shutdown.

Micro Focus Server Administrator

Back to the list

- If Enterprise Server Administration was set to restricted access, some MQ listener configuration pages would not be displayed.
  3152874 (1113782)
- The Enterprise Server Administration HTML UI no longer displays the IP address but only the host name used by the Web administration server process.
OpenSSL

*Back to the list*

- Visual COBOL, Enterprise Server, and Enterprise Developer now include an updated collection of public Certification Authority root and intermediate certificates (CARootCerts.pem) derived from the public collection maintained by Mozilla.org.

PL/I Support

*Back to the list*

- The optimization problem related to character literals has been fixed.
  3185930 (1116534)
- An issue which caused a run-time system failure on `ALLOCATE <structure with REFER> SET(<offset>)` has been fixed.
  3184177 (1116414)
- The Open PL/I compiler now supports XML tags using the case of declaration and attributes enclosed in double quotes. See the new compiler options `-xmlcase` and `-xmlattr`. The `*PROCESS XML` directive is also supported.
  3180475 (1116120)
- The Open PL/I compiler now supports new command-line options `-dummy aligned` and `-dummy unaligned`. In addition, `*PROCESS DEFAULT(DUMMY(ALIGNED|UNALIGNED))` is also supported.
  3180244 (1116091)
- An issue with `DEFAULT RANGE (*)` used in combination with a variable of type OFFSET has been fixed.
  3179782 (1116065)
- The `NOINIT` attribute is no longer ignored.
  3179191 (1116008)
- An issue causing the compiler to recursively loop during Restricted Expression Evaluation has been fixed.
  3178664 (1116009)
- Named constants of numeric PICTURE type are now supported in static structure dimensions and initializations.
  3176071 (1115764)
- The PL/I compiler now has increased limits to help prevent occurrences of the diagnostic message "MFPLI02012A: Internal IL overflow".
  3175119 (1115684)
- An issue with the `SIZE` and `STORAGE` built-ins returning an incorrect result for elementary data items of type CHAR ALIGNED has been corrected.
  3174904 (1115665)
- Comparison of an OFFSET variable with `SYSNULL()` or `NULL()` was erroneously producing a diagnostic message MFPLI00277.
  3172702 (1115461)
- You no longer receive incorrect error messages when compiling code which includes string array parameters.
  3172570 (1115453)
- An issue with the ONCODE built-in used with a condition prefix has been fixed.
• Internal compiler storage limits have been increased to allow for more complex expressions within DECLARE statements.

• Open PL/I now supports passing structures and arrays using a dummy argument and you no longer receive an MFPLI00109S error message.

• The diagnostic message MFPLI00064S now includes the argument number that would help to diagnose the application code. Any additional diagnostics have been modified in the same way.

• An issue initializing an ENTRY variable having a RETURNS descriptor with an INIT clause has been corrected.

• An issue where DEFAULT RANGE(*) was applied to descriptors has been fixed.

• You no longer receive a diagnostic message MFPLI04450S when using the WEEKDAY built-in function.

• PL/I now raises a diagnostic message MFPLI00445l, "OPTIONS(REORDER) is parsed but ignored".

• *PROCESS OPT(TIME) is now supported.

• The Open-PL/I compiler now recognizes PROCEDURENAME and PROCNAME as built-in functions when parenthesis, (), are not used.

• You could receive compiler errors if a macro generated code that caused a PL/I built-in function name to be split at the right margin.

• An issue when using the procedure option BYVALUE with PUT DATA statement has been fixed.

• A PL/I compiler optimization problem using the compiler options -opt -range causing incorrect execution behavior has been fixed.

• The use of condition prefixes no longer causes diagnostic message MFPLI04042A.

• An issue which caused a message "MFPLI04042A : Possible compiler error" has been resolved.

• An issue with multiple passes of the macro preprocessor and -margins 2,72 has been corrected.

• An issue with text beyond column 72 of a *PROCESS statement as been fixed.

• The Open PL/I compiler now supports the INOUT, INONLY, and OUTONLY attributes.

• The Open PL/I compiler now supports the REM built-in function.

• The MEMINDEX built-in function is now supported.
• The ALLOCATE and PLIFREE built-in functions are now supported.

• The REPLACEBY2 built-in is now supported.

• MEMCONVERT built-in function is now supported.

• Open PL/I now supports the INDEXR built-in function.

• ONCONDCOND built-in function is now supported.

• Open PL/I now supports the BETWEEN, BETWEENEXCLUSIVE, BETWEENLEFTEXCLUSIVE, and BETWEENRIGHTEXCLUSIVE built-in functions.

• Named constants in structures are now supported.

• Open PL/I now supports the HEX built-in with scalar and structure expressions. Restriction: Array expressions are not yet supported in this context.

• The GET DATA facility is now supported.

• The Open PL/I compiler now issues a W-level diagnostic when a bit operator (& |) is applied to a non-BIT operand.

• The Open PL/I compiler now generates a Warning-level diagnostic when a character string passed as an argument is longer than the corresponding parameter descriptor.

• The Open PL/I source listing map has been enhanced to show array dimension information. In addition, the listing map has been reformatted from 80 to 132 columns.

• An issue causing the SQL preprocessor to abort has been fixed.

• Previously, if recovering from a hardware generated signal, it was not possible to catch a second hardware generated signal. This has now been fixed.

• Previously, named constants allowed modification of the named constant when passed by reference.

• An issue with using the FREE statement with the IN clause has been fixed.

• The XMLDEMO example as shipped failed on the call to the PLISAXA API because the events structure passed to it was not using the required data type of ENTRY LIMITED. The examples have been updated to match the XML support.

• This release includes new sample programs for PL/I on UNIX. Refer to the readme file in the $COBDIR/demo/open-pli directory.

• The source code in the example and other similar variations are now processed correctly.
• Long path names for include files are now handled correctly.
  3148758 (1113423)

• Previously, when the macro preprocessor generated diagnostic MFPP09226E it did not correctly set the maximum error level upon exit. This has now been fixed.
  3181674 (1116183)

• The emulation of the ANSWER built-in function in the Micro Focus Macro Preprocessor now defaults to a starting position equal to MACCOL.
  3180174 (1116113)

• Previously, if invalid syntax for a macro was entered which resulted in a scan forward for a single block that exceeded 65535 bytes, then the macro preprocessor would fail without issuing a diagnostic indicating the cause. This no longer happens.
  3180037 (1116093)

• When running multiple macro passes using -margins 2,72 against a structure which contains structure level declarations in column 2, and commas terminating structure elements in column 72, a second macro pass caused a portion of the data structure to not be present in the output deck.
  3178876 (1116005)

• Previously, if emitting preprocessed code within margins 2,72 and a single byte delimiter occurred at exactly the right margin boundary, then it was erroneously placed in column 73.
  3172770 (1115467)

• Closing paren and semi-colons are no longer discarded in complex INIT statements.
  3168558 (1115071)

• Previously, the macro preprocessor would not correctly parse a WHEN statement that contained multiple expressions in which the expressions contained commas. This has now been fixed.
  3159116 (1114375)

• The PL/I Macro Preprocessor now supports the DO LOOP and DO FOREVER syntax.
  3158083 (1114215)

• Previously, if a macro variable caused the replaced text to be larger than the length of the macro variable, a %LINE was injected immediately following the next end of line marker. The new %LINE is now immediately injected after the next semi-colon.
  3152196 (1113737)

• Previously, when making an assignment to a file variable prior to establishing an ON unit for the file, and then attempting a comparison of the file variable to the FILE, the comparison would fail.
  3186873 (1116621)

• The enhancement for SI 3175398 (RPI 1115722) was not being honored in some scenarios when the Open PL/I Run-Time System was not unloaded between job steps in the batch initiator.
  3184952 (1116523)

• An issue where UNDEFINEDFILE was not raised for SYSIN when SYSIN utilized directly for record input has been fixed.
  3184839 (1116458)

• Previously, if a single character value was surrounded by two character references, the single character would not be emitted to the PLISAXA E15 event.
  3179171 (1116017)

• Previously, if a PL/I program which executed under Enterprise Server attempted to write to SYSPRINT DD without a SYSPRINT DD defined you received an error message that indicated FILE=stdout instead of FILE=SYSPRINT.
  3178595 (1115953)
• Previously, if using PLISAXA to parse an XML Structure, only attributes that were multiples of five were passed to the attribute callback routines.
  3177690 (1115889)
• Previously, if FILE declarations of differing DCB (RECFM, RECSIZE, etc.) were used to OPEN for OUTPUT the same DD defined in a JCL Jobstream the attributes of the datasets all matched the DCB of the first FILE opened using that JCL DD.
  3175398 (1115722)
• DATETIME patterns that previously raised an ERROR condition no longer do so.
  3174344 (1115647)
• Previously, if code was written which did a GET EDIT into a FIXED BIN variable specifying that the incoming data was in PIC format, a trap could occur. This has now been fixed.
  3168420 (1115138)
• Previously, if a PL/I application called a COBOL subroutine and the COBOL subroutine caused a COBOL Run-Time System Error, the PL/I ON ERROR units were not driven.
  3168339 (1115084)
• Non-local GOTO statements positioned outside of ON ERROR blocks used to reset the behavior of the ON ERROR SYSTEM; statement.
  3154846 (1116079)
• Previously, the FETCH statement would fail if the TITLE option was used in conjunction with a variable containing trailing spaces. This has now been fixed.
  3152827 (1113779)
• Open PL/I now supports dynamic allocations of z/OS datasets utilizing optional expressions in the TITLE option of the OPEN statement.
  3143632 (1112999)
• Previously, if operating in a mixed language environment of COBOL and PL/I, if a COBOL program triggered a hard error such as a SIGSEGV, there was no way to generate a Windows mini dump. See the documentation for MFPLI_MINIDMP environment variable for directions on how to enable the new functionality.
  3142342 (1112998)
• PLIDUMP output can now be configured using PLIDUMP_CONFIG environment variable
  3130920 (1111853)
• An issue causing the SQL preprocessor to abort has been fixed.
  3188874 (1116775)
• Execpp has been enhanced to allow very large PL/I statements.
  3184447 (1116396)
• Previously, if a macro was used to generate a parameter to a CALL statement, the EXEC preprocessor would erroneously omit an error message indicating that the CALL had mismatched parenthesis.
  3177094 (1115846)
• A comment immediately following a quoted string with no intervening characters used to cause an unbalanced parenthesis diagnostic.
  3177085 (1115842)
• Previously, when using the EXEC or INCLUDE preprocessors, if the number of %INCLUDE(d) or EXEC SQL INCLUDE(d) files exceeded 1000 then a severe error message was issued and processing terminated.
  3176715 (1115820)
• An SQL variable declaration of type BLOB having an underlying (1) dimension has been fixed.
  3174584 (1115631)
• Use of CONTROLLED variables in EXEC SQL statements no longer causes compiler failures.
  3171842 (1115395)
• The DB2 pre-compiler incorrectly generated swap logic for SQLCA numeric fields if not defined in the
  main section of PL/I program. This has now been fixed.
  3159844 (1114354)
• Trying to precompile a PL/I program containing both EXEC SQL and utilizing the PL/I package language
  construct produced an error.
  3134798 (1112169)

**Run-Time System**

**Back to the list**

• Under certain circumstances, if a file was opened multiple times and an error occurred, then any
  physical locks on the file could be lost.
  3177819 (1116043)
• In a threaded environment, when using critical-sections and simultaneously loading/unloading shared-
  objects, a race condition would sometimes create a deadlock. This no longer occurs.
  3177711 (1116154)
• The use of the P(COBSQL) Compiler directive in a Visual Studio or Eclipse project no longer causes the
  IDE to crash intermittently at termination.
  3133807 (1112077)
• The COBRT243 Class could not be loaded error message now contains the name of the class that
  could not be found.
  3104988 (1109420)
• Calls to CBL_MEM_VALIDATE might not have given the full memory corruption details if the corruption
  occurred in freed memory. This is now fixed.
• When using the Character Animator, you can enter Ctrl+C to interrupt the running process you are
  debugging. This would sometimes fail to stop the running process, but should now behave as expected.
• When setting the out-length parameter of the CBL_STRING_CONVERT API to zero in order to get the
  size of the buffer required for the conversion, the API no longer fails with a ArgumentNullException
  when running on the .NET environment. Under JVM COBOL, this API no longer corrupts the output
  buffer if the output length has been set to 0.
• In managed COBOL, for a very small set of cases for exponentiation and DIVIDE ROUNDED,
  performance was very poor. Also, for some of this set of cases, the result of DIVIDE ROUNDED could
  round in the wrong direction. These issues have been fixed.
  3185807 (1116589)
• Within JVM COBOL, a MOVE operation from a COMP-2 item containing a negative value to an
  unsigned COMP-5 item now gives the correct result.
  3175547 (1115719)
• Under JVM COBOL, RunUnit GetEnvironmentVariable() is now case insensitive on look-up of
  environment names.
  3161925 (1114545)
• CALL "SYSTEM" in a JVM COBOL program that is executed from a run unit in Java no longer produces
  a COBRT200 error if RunUnitStartupOptions.UseSingleThreadedRuntime is set.
  3151448 (1114573)
• JVM COBOL only. An issue has been resolved whereby some arithmetic expressions using a binary
  item (COMP, COMP-5) that had the value -2147483648 ( - 2**31 ) could result in stack overflow.
Setup Issues

Back to the list

• The Data File Tools AddPack can now be installed alongside Enterprise Server.
  3158290 (1114230)
• The installer error handling has been extended to cater for certain conditions.
  3152023 (1113706)

SQL: COBSQL

Back to the list

• COBSQL now handles "ELSE EXEC SQL" correctly when it is all on the same line in the source file.
  3176046 (1115778)
• The XAID option did not work properly for COBSQL when CHARSET(EBCDIC) was used.
  3174070 (1115697)
• A compilation error that was caused by the COBSQL preprocessor incorrectly handing sections declared inside of a copybook has been fixed.
  3164533 (1116863)
• An unreadable copybook caused COBSQL to loop when stacked with the CP preprocessor. This has been fixed.
  3156374 (1114103)
• An unreadable copybook caused COBSQL to loop when stacked with the CP preprocessor. This has been fixed.
  3156374 (637041)
• An issue that caused a compilation error when COBSQL encountered inline comments in an EXEC SQL statement has been fixed.
  3123025 (1111044)
• COBSQL messages have been updated to provide more information when failure is due to a missing list file, and when the list file is missing due to use of the LTYPE=NONE directive.
  2883514 (624749)
• To prevent exceeding the COBSQL directive buffer size, the maximum directive buffer size has been increased to a maximum of 8000 characters.
  2852872 (1104084)
• To prevent hanging or a compilation error, COBSQL has been updated to properly handle conditional statements in the same line as EXEC SQL statements.
  2804004 (1097225)
• An issue that sometimes caused SQL error text to display as truncated on the command line has been fixed by increasing the maximum error length to 250 characters, and updating the logic used to construct the message.
• An issue that caused an error when a space was present between an END-EXEC statement and a period has been fixed.
• The COBSQL precompiler interprets the SOURCETABSTOP COBOL compiler directive as SOURCETABSTOP(8) in all cases. This is due to Pro*COBOL honoring only SOURCETABSTOP(8), and is a permanent restriction for COBSQL.

SQL: HCO for DB2 LUW

Back to the list
- An optional 'FROM' keyword in SQL statements such as 'FETCH FROM <cursor-name>' used to cause compiler errors.
  3191635 (1116976)
- There is no longer an issue with negative line numbers being generated in the .bnd file when the COBOL source file has more than 32700 lines of code.
  3188178 (1116814)
- An issue with the DB2 preprocessor caused it to incorrectly classify PL/I variables greater than 4000 bytes as LONG VARCHAR when it should have classified PL/I variables less than 32767 bytes as VARCHAR as it does for COBOL variables. This has been fixed.
  3185976 (1116539)
- DB2 XA switch source is now shipped for Linux ppc64le platforms.
  3184287 (1116424)
- The DB2 pre-compiler incorrectly generated a compile error when hyphen was used in SQL command without a space between the hyphen and host variable name. This has now been fixed.
  3180089 (1116102)
- DB2 LUW now supports dashes in cursor names, so the DB2 pre-compiler no longer changes dashes to underscores in cursor names.
  3177271 (1115912)
- The DB2 pre-compiler incorrectly passed COBOL variable names to PL/I programs when generating code to handle EXEC SQL SET CURRENT PACKAGE PATH statements.
  3175885 (1115744)
- The DB2 and OpenESQL pre-compilers now qualify generated code that uses SQLSTATE to qualify SQLSTATE similar to this one: SQLCA.SQLSTATE.
  3173295 (1115512)
- An issue that caused the DB2 preprocessor to incorrectly reject FILLER as a valid host variable name in PL/I programs has been fixed.
  3164600 (1114767)
- An issue that occurred with user personalization on user names exactly eight characters long has been resolved.
  3156639 (1114163)
- When a DBCS database is used with CHARSET(EBCDIC), the data of a char field following a varchar field will no longer be corrupted.
  3155499 (1114065)

**SQL: HCO for SQL Server**

*Back to the list*

- An issue that prevented SQL Server from releasing all resources at the end of a CICS transaction has been corrected.
  3184561 (1116409)
- HOCSS applications that use DBRMLIB but are not bound before execution will now report runtime errors with SQLCODE -808 for all statements executed, and the possibility of a cursor open and subsequent fetch not returning any errors has been fixed.
  3155911 (1114082)
- The HCOSS Transfer Data tool user interface has been updated to clarify SQL Server requirements in cases where the SQL Server versions differ between the server and the client.
- An issue that occurred when using read-only WITH HOLD cursors, and when SQL(DBRMLIB) and SQL(ODBCV3) were both specified has been fixed.
The OpenESQL runtime has been updated to return a connection error when calling a stored procedure in a program compiled with the SPALLLOCAL directive, and no connection exists.

SQL: MBDT Utilities

There is no longer an issue with using more than one "AND/OR" statements in the WHEN clause for SQLUTB UNLOAD. An issue with the JCL parser in SQLUTB where parsing JCL input for SQLUTB UNLOAD has been fixed.

Space padding to the maximum length no longer occurs when loading EBCDIC data into VARCHAR fields if the "EBCDIC" option is specified on the LOAD card. The actual lengths of the loaded data are used in inserting data into the columns.

An issue with unintentionally submitting a JCL job to run SQLUTB when the XA is disabled has been resolved. The SQLUTB program now verifies the status of opening the XA connection before it proceeds.

In SQLUTB loads, formatted PIC X(8) - PIC X(10) fields that contained char values resembling times had '.' chars transformed to ':' incorrectly. For example, for "99.99.99" the result table would show "99:99:99". This is now prevented.

SQLUTB now returns COND CODE 8 (rather than 0) when it encounters an invalid DSN connection.

An issue that caused an SQL0007N error when loading data into a table with child relationships to empty tables has been fixed.

An issue that prevented the SQLUTB utility from extracting views and tables from DB2 LUW has been fixed.

When SQLUTB was run with input DD DUMMY, it returned an error message indicating that the input data had an LRECL of 0. This has been corrected so that SQLUTB now behaves as the IBM load utility, ignoring the DUMMY input LRECL.

An issue that occurred when using SQLUTB LOAD without field specifications in the JCL has been fixed.

The SQLUTB utility, when run on Linux Red Hat machines, failed to produce meaningful error messages. This has been corrected.

There is no longer an issue with using synonyms to load data into the underlying tables for SQL Server with SQLUTB. An issue with truncating tables via synonyms in SQL Server has been fixed for SQLUTB.
• JDBC now returns SQLCODE=+1 when the fetched value is NULL and NULL indicator is not used.
  3191192 (1116953)
• Decimal value is now inserted correctly into Oracle DB when DECDEL=COMMA is set.
  3189836 (1116947)
• An issue that caused performance degradation when using a STATIC cursor has been fixed.
  3185894 (1116518)
• The OpenESQL run-time now handles the compiler directive SQL(NOAUTOFETCH) correctly.
  3177780 (1115994)
• OpenESQL has been updated to provide cobrhcedsn64.so for 64-bit only platforms.
  3174065 (1116801)
• HCOSS now accepts FOR READ ONLY clauses in cursors before FETCH FIRST clauses. This is
  undocumented behavior for DB2 z/OS but HCOSS now supports it to ensure mainframe compatibility.
  3173586 (1115528)
• An issue where WITH HOLD cursors could remain open after an IMS transaction had terminated for
  SQL Server, ODBC and PostgreSQL XA resources has been fixed. SQL(NOCHECKDUPCURSOR) can
  now be used to override duplicate cursor checking when SQL(DIALECT=MAINFRAME) is used.
  3172382 (1115430)
• A new SQL directive [NO]ALLOWSERVERSELECT supports server-specific SELECT statements that
  are not recognized by OpenESQL as valid ESQL SELECT ... INTO statements. This behavior was the
  default in Net Express.
  3165092 (1114866)
• An issue that caused the OpenESQL runtime to incorrectly handle binary parameter markers for PIC
  X(n) VARYING host variables has been fixed.
  3163759 (1114719)
• The SQL Directives dialog box that appeared for .NET project types in the Visual Studio IDE
  erroneously omitted the SQL(HSFTRACE) option for DBMAN=ADO. This has been fixed.
  3162428 (1114593)
• Data type information that was incorrectly mapped by the OpenESQL Assistant caused it to display
  column information improperly when using an IBM DB2 ADO.NET provider connected to a DB2 z/OS
  data source. This has been corrected.
  3161285 (1114478)
• An issue that occurred when the SQL BEHAVIOR compiler directive option was set to UNOPTIMIZED
  caused the OpenESQL runtime to generate an RTS 114 error when the COBOL application exited. This
  has been fixed.
  3158065 (1114288)
• Problems with SQL Server and PostgreSQL that surfaced when working with large binary columns have
  been fixed.
  3156215 (1114335)
• An issue that caused the OpenESQL preprocessor to generate an incorrect error message when
  SQL(DBRMLIB) was not set prior to specifying SQL(VERSION) has been fixed; the OpenESQL
  preprocessor now generates the correct error message.
  3155275 (1114004)
• SQL FETCH ABSOLUTE CURSOR was not returning rows. A COMP position value is now supported in
  the SQL FETCH ABSOLUTE/RELATIVE statement and it behaves as expected.
  3153738 (1113903)
• An issue that prevented HCOSS from correctly handing IS [NOT] DISTINCT predicates has been fixed.
  3152630 (1113764)
• An issue that caused HCOSS to incorrectly apply QUALIFIERs to common table expression names has been fixed.
  3152008 (1113714)
• The DSNRLI function SWITCH TO is now supported for Enterprise Server Mainframe Subsystem applications using DB2, Microsoft SQL Server, and PostgreSQL.
  3151779 (1113680)
• An issue that caused HCOSS to incorrectly handle FETCH FIRST ROW ONLY when no literal row count was present has been fixed.
  3151398 (1113734)
• An issue that caused the OpenESQL runtime to execute a core dump on exit when the MEMORY_STRATEGY tunable was set has been fixed.
  3142107 (1113077)
• A program that contained zoned decimal host variables used in SQL statements and compiled using charset(EBCDIC) and dialect(MF) sometimes caused a run-time error. This has been corrected.

SQL Option for DB2

  Back to the list

• The XDB pre-compiler incorrectly generated line and column number information used by the IDE to get COBOL information about field on EXEC SQL INSERT statements.
  3182574 (1116350)
• The XDB pre-compiler incorrectly tried to generate interface logic in nested COBOL routines without checking if a SQLCA copybook was defined. This resulted in an "Undefined ECM error" error message. This has been fixed.
  3168445 (1115099)
• An issue caused by an uninitialized stack variable that resulted in a server violation has been fixed.
  3168714 (1115237)
• A number of XDB components have been enhanced to better implement bulk INSERT/UPDATE/ MERGE statements using both local XDB engines and XDB Link in dynamic and static mode to z/OS DB2.
  3175084 (1115695)
• XDB Link has been updated to support the invocation of stored procedures that return multiple result sets on z/OS DB2.
  3168036 (1115315)
• A memory leak in DRDA Continue Query Reply Message processing has been fixed.
  3160580 (1114426)
• An issue that prevented XDB Server configuration from allowing the full length of 16 characters in the Global Security Location text box has been fixed.
  3168821 (1115106)
• An issue with SQL step processing related to CASE expression evaluation that caused the SQL COALESCE scalar function to return the wrong result has been fixed.
  3160595 (1114413)
• Support has been added for the SOUNDEX() and DIFFERENCE() scalar functions.
  3155733 (1114043)
• An issue that caused a buffer overflow when processing a very large UPDATE WHERE CURRENT OF in the XDB Link has been resolved.
• An issue with join optimization using differing lengths of DECIMAL data has been resolved.

• An issue with a scalar query using a DATETIME value returning an error indicating that the value was invalid has been resolved.

• An issue with Query Descriptor mapping when performing XDB Server to Server connectivity has been fixed.

• An issue with an uninitialized stack space causing a thread abend in XDB SQLDA code page processing has been fixed.

Web Service Client

Back to the list

• When a generated Web service client executes, an additional optional user-supplied exit program, exit-http-resp-headers, is now called to provide access to any and all HTTP headers present in the response message from the service.

XML Support

Back to the list

• XML PARSE now handles "WITH ENCODING" clauses correctly.

• Data within the CDATA tag is now processed by the managed XML syntax support run-time.

• XML PARSE did not handle lengthy CONTENT-CHARACTERS correctly which caused the event to be returned twice.

• Literals positioned beyond column 72 in the editor are now being handled correctly and compile without any issues.
Other Issues Resolved in This Release

The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI) number (in parentheses).

<table>
<thead>
<tr>
<th>Incident Numbers</th>
<th>Support Incident Numbers</th>
<th>RPI Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>3177187</td>
<td>1115851</td>
<td>3158311</td>
</tr>
<tr>
<td>3181887</td>
<td>1116201</td>
<td>3158072</td>
</tr>
<tr>
<td>3177661</td>
<td>1116118</td>
<td>3141381</td>
</tr>
<tr>
<td>3134735</td>
<td>1112201</td>
<td>3164533</td>
</tr>
<tr>
<td>3170148</td>
<td>1115245</td>
<td>3193749</td>
</tr>
<tr>
<td>3171080</td>
<td>1115373</td>
<td>3158936</td>
</tr>
<tr>
<td>3161109</td>
<td>1114775</td>
<td>3156405</td>
</tr>
<tr>
<td>3160774</td>
<td>1114530</td>
<td>3152246</td>
</tr>
<tr>
<td>3187594</td>
<td>1116668</td>
<td>3157702</td>
</tr>
<tr>
<td>3176925</td>
<td>1115833</td>
<td>3157956</td>
</tr>
<tr>
<td>2802311</td>
<td>1097060</td>
<td>3127953</td>
</tr>
<tr>
<td>3140337</td>
<td>1112673</td>
<td>3159456</td>
</tr>
<tr>
<td>3175137</td>
<td>1115685</td>
<td>2867519</td>
</tr>
<tr>
<td>3170946</td>
<td>1115402</td>
<td>3191105</td>
</tr>
<tr>
<td>3128586</td>
<td>1111526</td>
<td>3174042</td>
</tr>
<tr>
<td>3108578</td>
<td>1109394</td>
<td>3176098</td>
</tr>
<tr>
<td>2990180</td>
<td>1108737</td>
<td>3172981</td>
</tr>
<tr>
<td>2854004</td>
<td>1103682</td>
<td>3127698</td>
</tr>
<tr>
<td>2851622</td>
<td>1103230</td>
<td>3189442</td>
</tr>
<tr>
<td>2844942</td>
<td>1102368</td>
<td>3188582</td>
</tr>
<tr>
<td>2841043</td>
<td>1102369</td>
<td>3178509</td>
</tr>
<tr>
<td>2590883</td>
<td>1085717</td>
<td>3160759</td>
</tr>
<tr>
<td>3181941</td>
<td>1116211</td>
<td>3150188</td>
</tr>
<tr>
<td>3103315</td>
<td>1109252</td>
<td>3177187</td>
</tr>
<tr>
<td>2990950</td>
<td>1108778</td>
<td>3181887</td>
</tr>
<tr>
<td>2865338</td>
<td>1105207</td>
<td>3177661</td>
</tr>
<tr>
<td>2597474</td>
<td>1088223</td>
<td>3134735</td>
</tr>
<tr>
<td>3164898</td>
<td>1114811</td>
<td>3170148</td>
</tr>
<tr>
<td>3150507</td>
<td>1113583</td>
<td>3171080</td>
</tr>
<tr>
<td>3122080</td>
<td>1110968</td>
<td>3161109</td>
</tr>
<tr>
<td>3122020</td>
<td>1110949</td>
<td>3160774</td>
</tr>
<tr>
<td>3114654</td>
<td>1110269</td>
<td>3187599</td>
</tr>
<tr>
<td>2887726</td>
<td>1108356</td>
<td>3176925</td>
</tr>
<tr>
<td>2885799</td>
<td>1108108</td>
<td>2802311</td>
</tr>
<tr>
<td>2873642</td>
<td>1106416</td>
<td>3140337</td>
</tr>
<tr>
<td>2835954</td>
<td>1102368</td>
<td>3170946</td>
</tr>
<tr>
<td>2795293</td>
<td>1086771</td>
<td>3170946</td>
</tr>
<tr>
<td>2652488</td>
<td>1090826</td>
<td>3128586</td>
</tr>
<tr>
<td>2587952</td>
<td>1086146</td>
<td>3105876</td>
</tr>
<tr>
<td>3123593</td>
<td>1111108</td>
<td>2990180</td>
</tr>
<tr>
<td>2642528</td>
<td>1090004</td>
<td>2854004</td>
</tr>
<tr>
<td>2594601</td>
<td>1086032</td>
<td>2851622</td>
</tr>
<tr>
<td>3181445</td>
<td>1111108</td>
<td>2844942</td>
</tr>
<tr>
<td>3168020</td>
<td>1115032</td>
<td>2841043</td>
</tr>
<tr>
<td>3164533</td>
<td>1115215</td>
<td>2850883</td>
</tr>
<tr>
<td>3162064</td>
<td>1114546</td>
<td>3181941</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3150188</td>
</tr>
<tr>
<td>Other Issues Resolved in This Release</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 3161964 (1114569)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 3103315 (1109252)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 3187219 (1116640)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 3172126 (1115445)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Unsupported Functionality

This section includes information about features or functionality that are no longer supported.

- The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE. This is a change since version 3.0 of this product.
Installation

Before Installing

Downloading the Product

1. Use the download links in your Electronic Product Delivery email.
   For more information follow the links for the installation instructions and the End User License Agreement.

On Windows

System Requirements

Hardware Requirements
The disk space requirements are approximately:

<table>
<thead>
<tr>
<th>Enterprise Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 GB</td>
</tr>
</tbody>
</table>

Note: This includes the space needed to cache information locally so that you can modify the installation without the original source media.

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note:
• This product can be installed on earlier versions of Windows but it has not been tested on them.
• Support for development on Windows 8 and Windows Server 2012 has been discontinued. These platforms are still supported for deployment. Windows 8.1 and Windows Server 2012 R2 are supported.

Software Requirements

Note:
• The setup file will check your machine for whether the prerequisite software is installed and will install any missing prerequisites and the product components.
• This product includes OpenSSL version 1.1.1b.

Before installing this product, you must have the following software installed on your computer:

• The Microsoft .NET Framework - the setup file installs the .NET Framework 4.5.2. You might need to install the following version of the .NET framework manually, if it is targeted by your applications:
  • Microsoft .NET Framework 2 - if your applications use the ILCLR(2) Compiler Directive or if they target the .NET Framework versions 2, 3 or 3.5. You might need to download these installers depending on the .NET Framework you are targeting.
To download the Microsoft .NET Framework 2 click here.

Microsoft .NET Framework 2 or later is also required for the Micro Focus License Manager if you install this on a separate machine as a license server.

**Note:**
- .NET Framework 3.5 is provided with Windows 7 and Windows Server 2008 R2.
- .NET Framework 4.0 is provided with Windows 7 and Windows Server 2008 R2.
- .NET Framework 4.5 is provided with Windows 8 and Windows Server 2012.
- .NET Framework 4.5.1 is provided with Windows 8.1 and Windows Server 2012 R2.
- .NET Framework 4.6.2 is provided with Windows 10 and Windows Server 2016.
- Microsoft's Web Platform Installer 2.0 if your application targets ASP.NET 4. This installs and sets up ASP.NET. To download the installer click here.

- A Web browser is required for Enterprise Server Administration in Enterprise Server.
  To use your Web browser offline, you need the dial-up networking feature of Windows installed. Otherwise you might have TCP/IP errors such as being unable find "localhost" or the numeric equivalent (127.0.0.1).
- To use Enterprise Server Administration, scripting or JavaScript support must be enabled in your browser. This is on by default in Internet Explorer in most Windows operating systems. Also, active content must be allowed and not blocked. To enable both these in Internet Explorer:
  1. Click **Tools > Internet Options**.
  2. On the **Security** tab, click **Custom Level**. In the **Scripting** section, under **Active Scripting**, click **Enable**.
  3. On the **Advanced** tab, scroll down the list to the **Security** section, and ensure the item **Allow active content to run in files on My Computer** is checked.

**Important:** For local servers, you do not need to install the Micro Focus License Administration tool separately, as the setup file installs a new Enterprise Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the client is not able to communicate with license servers of versions older than 10000.2.660. On Windows, you can check the version of your license server by clicking **Help > About** in the Micro Focus License Administration tool. To check the version of the license server on UNIX, run `/var/microfocuslicensing/bin/mfcesver` or `/var/microfocuslicensing/bin/cesadmintool.sh`.

If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled before the product installation or upgrade can continue.

You can download the new version of the license server software from the Micro Focus SupportLine Web site: [http://supportline.microfocus.com](http://supportline.microfocus.com).

**Additional Software Requirements**

To ensure full functionality for some Enterprise Server features, you might be required to obtain and install additional third-party software in addition to the prerequisite software installed automatically by the Enterprise Server setup file.

*Click here* to see this information on the Product Documentation pages on Micro Focus SupportLine.

**Installation Restrictions and Requirements**

Before starting the installation, you should consider the following:
• You need to be logged in with a user-ID that has write access to the registry structure under HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation software can set the environment appropriately. You also need to be logged on with Administrator privileges.

• Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or CCITCP2 Windows service (on Windows) or a process (on UNIX) from an existing product is stopped and uninstalled. On Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI (services.msc) or from a command line prompt by typing:

   ```
   net stop mf_ccitcp2
   ```

   Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.

2. Uninstall the MFDS or CCITCP2 service.

   For MFDS, from a command line prompt enter: `mfds -u`

   For CCITCP2: `ccitcp2 -u`

To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.

2. Reinstall the earlier version, as follows:

   a. Open an Enterprise Server command prompt.
   b. Install the service. Enter the following command: `mfds -i`
   c. Start the service. Enter the following command: `net start mf_ccitcp2`

   **Note:** The two versions use different paths for environment and registry values, so the list of configured enterprise servers might be different depending on which version has been started, since, by default, different MFDS data repositories are used.

   MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later versions.

   It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the "mfcobol" port is used (86) and this can only be used by one process at a time

**Product Co-Existence**

**Note:** The following applies to Windows only.

• Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same machine.

• Enterprise Server and Enterprise Test Server cannot coexist on the same machine.

**On UNIX**

**System Requirements**

**Hardware Requirements**

The disk space requirements are approximately:
<table>
<thead>
<tr>
<th>Platform</th>
<th>Installer type</th>
<th>Setup file size</th>
<th>Disk space required for the installation</th>
<th>Disk space required for running the product</th>
<th>Sentinel RMS license server</th>
</tr>
</thead>
<tbody>
<tr>
<td>POWER running AIX</td>
<td>Micro Focus</td>
<td>452 MB</td>
<td>1.81 GB</td>
<td>904 MB</td>
<td>41 MB</td>
</tr>
<tr>
<td>HP IA</td>
<td>Micro Focus</td>
<td>865 MB</td>
<td>3.46 GB</td>
<td>1.77 GB</td>
<td>79 MB</td>
</tr>
<tr>
<td>System Z running Red Hat Linux</td>
<td>Micro Focus</td>
<td>358 MB</td>
<td>1.43 MB</td>
<td>716 MB</td>
<td>39 MB</td>
</tr>
<tr>
<td>x86-64 running Red Hat Linux</td>
<td>Micro Focus</td>
<td>456 MB</td>
<td>1.82 GB</td>
<td>912 MB</td>
<td>50 MB</td>
</tr>
<tr>
<td>ppc64le running Red Hat Linux</td>
<td>Micro Focus</td>
<td>244 MB</td>
<td>976 MB</td>
<td>488 MB</td>
<td>1 MB</td>
</tr>
<tr>
<td>SPARC running Solaris</td>
<td>Micro Focus</td>
<td>466 MB</td>
<td>1.86 GB</td>
<td>932 MB</td>
<td>41 MB</td>
</tr>
<tr>
<td>x86-64 running Solaris</td>
<td>Micro Focus</td>
<td>406 MB</td>
<td>1.62 GB</td>
<td>812 MB</td>
<td>33 MB</td>
</tr>
<tr>
<td>System Z running SUSE SLES</td>
<td>Micro Focus</td>
<td>247 MB</td>
<td>988 MB</td>
<td>494 MB</td>
<td>39 MB</td>
</tr>
<tr>
<td>x64 running SUSE SLES</td>
<td>Micro Focus</td>
<td>313 MB</td>
<td>1.25 GB</td>
<td>626 MB</td>
<td>50 MB</td>
</tr>
<tr>
<td>ppc64le running SUSE SLES</td>
<td>Micro Focus</td>
<td>214 MB</td>
<td>856 MB</td>
<td>428 MB</td>
<td>1 MB</td>
</tr>
</tbody>
</table>

**Operating Systems Supported**


**Software Requirements**

*Note:* This product includes OpenSSL version 1.1.1b.

Before installing this product, you must have the following software installed on your computer:

- The "ed", "sed" and "tar" utilities must be installed and added to the PATH.
- The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems but, if it is missing, you must install it separately. To verify pax is installed, run `pax --help` or `pax --version` at the command line.
- Required libraries for Red Hat and SUSE Linux platforms - The installer checks that both the 32-bit and 64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating Systems for this product to install and work correctly.
  
  If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before you start the installation.
Visit the Red Hat Web site for more information.

1 On SUSE 12, you can only install the 64-bit version of this product. The glibc-locale-32bit library is still required by the SafeNet Sentinel licensed components.

• Java 8 (32 or 64-bit versions), and Java 11 (64-bit version only) are supported for executing JVM COBOL code and for native COBOL and Java interoperability. You can download AdoptOpenJDK's OpenJDK 8 with Hotspot from AdoptOpenJDK's Web site and unpack the archive anywhere on your machine.

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK is 7.0 Service Refresh 8. If you install IBM's JDK 8, on AIX you must install its latest fix - JDK 8 SR5 FP16. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK 7.0.11. You can get the HP-UX Java JDK from HP's Web site.

• On Solaris platforms (both SPARC and Intel) only the 64-bit version of Java 8 and later is supported.

Before you start the installation, you need to set the environment as follows:

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are English and Japanese only.

• JavaScript or scripting support must be enabled in your browser, so that Enterprise Server Administration is usable. Also, active content must be allowed and not blocked.

Important: For local servers, you do not need to install the Micro Focus License Administration tool separately, as the setup file installs a new Enterprise Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the client is not able to communicate with license servers of versions older than 10000.2.660. On Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run `/var/microfocuslicensing/bin/mfcesver` or `/var/microfocuslicensing/bin/cesadmintool.sh`.

If Micro Focus License Manager version 10000.2.02070 or older is installed, it must be uninstalled before the product installation or upgrade can continue.

You can download the new version of the license server software from the Micro Focus SupportLine Web site: [http://supportline.microfocus.com](http://supportline.microfocus.com).

Additional Software Requirements on Linux and UNIX

To ensure full functionality for some Enterprise Server features, you might be required to obtain and install additional third-party software in addition to the prerequisite software installed automatically by the Enterprise Server setup file.

*Click here* to see this information on the Product Documentation pages on Micro Focus SupportLine.

UNIX and Linux Installer Issues

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you have a local user ID which SOA and Enterprise Developer components of the product can use. This user ID must be set up prior to running the installer. When running the installer you need to specify `-ESadminID=[User ID]` on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the `/etc/hosts` file:

```text
127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname
```

where `IP` is the unique IP address of the computer in `xx.xx.xx.xx` format.

Basic Installation

The instructions in this section apply when you are performing a basic installation of this product for the first time. If you are an administrator, you can perform a basic installation on a local machine before performing a more advanced installation when rolling out the product to developers within your organization.

For considerations when installing this product as an upgrade, for additional installation options or non-default installations and for installing the mainframe components, see *Advanced Installation Tasks* in your product Help.

Installing on Windows

*Note:* If there is an earlier version of Enterprise Server installed on your machine, check *Installing as an Upgrade* first.

These are the steps to install this product:

1. Run the `es_50.exe` file and follow the wizard instructions to install the prerequisite software and the product.
The setup file will also install any missing prerequisite software as listed in Software Requirements.

**Note:**

- If you are installing onto a machine that has an existing Micro Focus product that uses an older Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus License Administration. By doing this you maintain the existing Sentinel RMS license files while adding the Micro Focus License Administration. If you are unsure about existing licenses on your computer or removing the Sentinel RMS License Manager, consult your System Administrator. If you want to proceed, remove Sentinel RMS License Manager by using Program and Features (Windows Vista or later), and rerun the installation file.
- Trial licenses cannot be used with remote desktop services. If you want to use your product in this way, please contact Micro Focus Support Line to obtain a relevant license.
- We recommend that you install any updates for the .NET Framework that are available at the Microsoft Download site.
- If you install JDK you might be prompted to install the latest update. The latest update is not required for use with Enterprise Server but you can install it if you wish.

## Installing on UNIX

**Note:** Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:
   ```bash
   chmod +x setup_ent_server_5.0_platform
   ```
2. Run the installer with superuser permissions:
   ```bash
   ./setup_ent_server_5.0_platform
   ```
   If you don't run this as superuser, you are prompted to enter the superuser password during the install.

   If you set COBDIR to an already installed product, the installer will back up the existing installation and will install this release in the location COBDIR points to. If COBDIR is not set, the installer does a fresh install.

   The COBOL run-time is installed by default into /opt/microfocus/EnterpriseDeveloper, (COBDIR).

**Note:**

During the installation process, the installer configures the product's Enterprise Server System Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process (Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To change the user id after you complete the installation, execute `$COBDIR/bin/casperm.sh`.

### SafeNet Sentinel considerations

- The installation of this product could affect the SafeNet Sentinel licensed components running on your machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes running on your machine are not affected, you need to use the `-skipsafenet` option, which skips the installation of SafeNet:
  ```bash
  ./setup_ent_server_5.0_platform -skipsafenet
  ```
• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

```
touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL
```

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the running license daemons. If licensing needs to be updated later, remove the file and install Sentinel RMS server manually.

Advanced Installation Tasks (Windows)

This section includes instructions about how to perform a non-default installation, install this product as an upgrade, or about how to install any additional components.

The advanced installation tasks include:

• Installing as an Upgrade
• Command line installation options

To see this information on the Product Documentation pages on Micro Focus SupportLine, click here.

Installing as an Upgrade

Before installing, check Installation Restrictions and Requirements.

Installing this release as an upgrade will automatically uninstall any HotFixes of the older version of the product you have installed on your machine.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server configuration. To do this, on the Enterprise Server Administration home page, click Export and then select Export Enterprise Server configuration and Security Manager definitions. This creates a backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can restore the Enterprise Server configuration after installing this release - click Import on the Enterprise Server Administration home page.

Enterprise Server Installation Options

To install Enterprise Server you run es_50.exe which contains a number of product .msi files (Windows Installer packages). When run, es_50.exe performs some initial system checks then sequentially installs the .msi files.

es_50.exe can take a number of parameters, enabling you to specify a number of different types of installation:

• Standard Installation

  Format:
  es_50.exe

  Summary:
  Full installation including License Manager and Enterprise Server. During installation you can specify options including the location to which the components are installed.

• Non-interactive Installation

  Format:
  es_50.exe /passive

  Summary:
  Full installation, but the components are installed non-interactively using default options and directories.
• Silent Installation

**Format:**
start /wait es_50.exe /q

**Summary:**
Full installation, but the components are installed non-interactively with no user interface, using default options and directories.

• Modified Silent Installation

**Format:**
start /wait es_50.exe /q InstallFolder=d:\cobolrts

**Summary:**
Full installation, but the components are installed non-interactively with no user interface, and Enterprise Server is installed to d:\cobolrts.

To see what parameters you can use, execute the following from the command line: es_50.exe /?.

**Note:**
- Log files that are created during installation are saved in the folder specified by the TEMP environment variable. To change the location or name of the files, use the /log parameter on your setup command line and specify the path and file name, for example: filename /log d:\temp \log.txt. This creates a log file, named log.txt, in the d:\temp directory.

Advanced Installation Tasks (UNIX)

This section includes instructions about how to perform a non-default installation, install this product as an upgrade, or about how to install any additional components.

The advanced installation tasks include:

- **Installing as an Upgrade** - included in these Release Notes
- **Command line installation options** - included in these Release Notes
- **Installing using an RPM installer on Linux** - available in the product Help and in the Micro Focus Infocenter

*Click here* to see this information on the Product Documentation pages on Micro Focus SupportLine.

Installing as an Upgrade

This release works concurrently with the previous version of Enterprise Server, so you do not need to uninstall it.

Install the latest version in a different location and set the environment to point to it. To do this, run the Enterprise Server installer with the –installlocation option:

1. Execute the following command:

   ./InstallFile –installlocation="/opt/microfocus/EnterpriseDeveloper"

   **Note:** You can use variables when specifying an absolute path for –installlocation. For example, the following examples are equivalent:

   -installlocation="/home/myid/installdir"
   -installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

   . <product-install-dir>/bin/cobsetenv
Note: `cobsetenv` is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is not compatible with C-shell or pre-XPG4 Bourne shell.

## Installation Options

### Installing into a different location

To install in a different location use the `-installlocation="Location"` parameter to specify an alternative directory location. For example:

```
./ -installlocation="full path of new location"
```

Note: You can use variables when specifying an absolute path for `-installlocation`. For example, the following examples are equivalent:

```
-installlocation="/home/myid/installdir"
-installlocation="$HOME/installdir"
```

You can see details about which additional parameters can be passed to the install script if you enter the `--help` option.

### Configuring Enterprise Server

You can use the following options to configure the Enterprise Server installation:

```
[ -ESsysLog="Y/N" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:
```

- **-ESsysLog** Use this to enable ("Y") or disable ("N") Enterprise Server system logging. Logging is enabled by default. Log files are saved in `/var/mfcobol/logs`.

- **-ESadminID** Sets the Enterprise Server System Administrator Process User ID from the command line - for example, `-ESadminID="esadm"`. The default user ID is the one that runs the installer.

- **-CASrtDir** Specifies the location were the Enterprise Server run-time system files are placed - for example, `-CASrtDir="/home/esuser/casrt/es"`. The default location is `/var/mfcobol/es`.

### Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation directory, user information, and which features to install. You must execute the command with superuser permissions.

You can use the following command line arguments to install silently on UNIX/Linux. You need to execute the commands as root:

```
-silent -IacceptEULA
```

For example, execute:

```
setup_filename -silent -IacceptEULA
```

### After Installing

- See `Changes in Behavior or Usage` in your product documentation and in the Release Notes for important information about changes in this release that might affect existing applications.
- Check the `Product Documentation` section of the `Micro Focus SupportLine Web site` for any updates to the documentation which might have been uploaded.
On Windows

To access the Enterprise Server help:

• On versions of Windows 7 and earlier, select Start > All Programs > Micro Focus Enterprise Server > Documentation from the Windows Taskbar.

• On Windows 8, right-click at the bottom of the Start screen, and click All apps to display all available links for this product. In the Enterprise Server section, click Documentation.

This opens the online Micro Focus Infocenter in a browser. From the left-hand pane, select Enterprise > Micro Focus Enterprise Server.

Repairing

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product directory has not been removed, delete any unwanted files and subdirectories within it using Windows Explorer.

Important: The installer creates separate installations for Micro Focus Enterprise Server and Micro Focus License Administration. Uninstalling only Enterprise Server does not automatically uninstall the Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the command line:

```cmd
start /wait install-file.exe /quiet /uninstall
```

On UNIX

Setting the Environment

When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:
   ```bash
   . <product-install-dir>/bin/cobsetenv
   ```
2. To verify that your product is installed, execute:
   ```bash
   cob -V
   ```
**Important:** These commands set the environment only for the current shell. You need to execute them for each new shell that you start.

To avoid having to run `cobsetenv` for every shell, add these commands to the shell initialization files (such as `/etc/profile`, `/etc/bashrc`).

Note that `cobsetenv` is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is not compatible with C-shell or pre-XPG4 Bourne shell.

**Repairing**

If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall the product.

**Uninstalling**

**Note:** Before you uninstall the product, ensure that the Enterprise Server instances and the Micro Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the `Uninstall_EnterpriseServer5.0.sh` script in the `$COBDIR/bin` directory.

**Note:** The installer creates separate installations for the product and for Micro Focus License Administration. Uninstalling the product does not automatically uninstall the Micro Focus License Administration or the prerequisite software. To completely remove the product you must uninstall the Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the `UnInstallMFLicenseServer.sh` script in the `/var/microfocuslicensing/bin` directory.

   The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the respective software vendor.
Licensing Information

Note:

- If you have purchased licenses for a previous release of this product, those licenses will also enable you to use this release.
- If you are unsure of what your license entitlement is or if you wish to purchase additional licenses, contact your sales representative or Micro Focus SupportLine.

To start Micro Focus License Administration

Windows 8, 8.1, and Windows Server 2012
• From the Windows Start screen, click the License Administration tile

Windows 10 and Later
• From your Windows desktop, click Start > Micro Focus License Manager > License Administration

Log on as root, and from a command prompt type:
/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses

You need either a license file (with a .mflic extension) or an authorisation code which consists of a string of 16 alphanumeric characters.

If you have a license file

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:
   • Click Browse next to the License file field and select the license file (which has an extension of .mflic).
   • Drag and drop the license file from Windows Explorer to the License file field.
   • Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file into the box below the License file field.
4. Click Install Licenses.

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by entering 4.
2. Enter the name and location of the license file.

If you have an authorization code

Authorizing your product when you have an Internet connection

Note:

- It is not possible to install licenses remotely. You must be logged into the machine on which you are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server. The license server is set up automatically when you first install the product.

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the licenses stop working.

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection

This method of authorization is required if the machine you want to license does not have an Internet connection or if normal (automatic) authorization fails.

1. Start Micro Focus License Administration.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:
   - If your machine has an Internet connection, click the SupportLine Web link in the Manual Authorization Information window.
   - If your machine does not have an Internet connection, make a note of the Web address and type it into a Web browser on a machine that has an Internet connection.

   The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License file field on the Install page.
10. Click Install Licenses.
In order to authorize your product you must have the following:

- Access to a computer which is connected to the Internet.
- Your authorization code (a 16-character alphanumeric string).
- The machine ID. To get this, start the Micro Focus License Administration tool and select the Get Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a browser.
2. Enter your authorization code and old machine ID and, optionally, your email address in the Email Address field.
3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
7. Enter the name and location of the license file.

To obtain more licenses

If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Enterprise Developer, contact your sales representative or Micro Focus SupportLine.
Updates and SupportLine

Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support

Additional technical information or advice is available from several sources. The product support pages contain a considerable amount of additional information, such as:

- The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes and documentation updates. Go to https://supportline.microfocus.com/websync/productupdatessearch.aspx
- The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting guides and information about how to raise an incident. Go to https://supportline.microfocus.com/supportresources.aspx

To connect, enter https://www.microfocus.com in your browser to go to the Micro Focus home page, then click Support & Services > Support > Support Resources > All Support Resources by Product. In the Browse by Product field, click the product you require, and then click Log into SupportLine.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web site, https://www.microfocus.com/support-and-services/contact-support/. If you obtained the product from another source, such as an authorized distributor, contact them for help first. If they are unable to help, contact us.

Also, visit:

- The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and blogs, find demonstration programs and examples, and discuss this product with other users and Micro Focus specialists. See https://community.microfocus.com.
- The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/user/MicroFocusIntl.

Information We Need

However you contact us, please try to include the information below, if you have it. The more information you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or you think some are irrelevant to your problem, please give whatever information you have.

- The name and version number of all products that you think might be causing a problem.
- Your computer make and model.
- Your operating system version number and details of any networking software you are using.
- The amount of memory in your computer.
- The relevant page reference or section in the documentation.
- Your serial number. To find out these numbers, look in the subject line and body of your Electronic Product Delivery Notice email that you received from Micro Focus.
On Windows, if you are reporting a protection violation you might be asked to provide a dump (.dmp) file. To produce a dump file you use the **Unexpected Error** dialog box that is displayed when a protection violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as **Normal** (recommended), click **Dump**, then specify a location and name for the dump file. Once the dump file has been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create either:

- a .log file that contains the details about your environment, Micro Focus SupportLine products, and settings.
- a .zip archive that includes the same information as the .log file plus some product configuration files from `c:\ProgramData` and the product installation log files.

MFSupportInfo.exe is stored in `<install-dir>\bin`.

**To run MFSupportInfo:**

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter `MFSupportinfo` at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:
   a. To create a .log file, click **File > Save**.

   **This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-SS.log, in the %temp% directory.**
   
   b. To create a .zip archive, click **Tools > Create Zip Package**.

   **This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-SS.zip, in the %temp% directory.**

4. Send the diagnostic information to your Micro Focus SupportLine representative:

   The following requires an Internet connection and an Email client:
   a. Click **Tools > Email Log to SupportLine** to open the **Email Log** dialog box.
   b. Fill in the required fields and click **Send**.

   If the machine is not connected to the Internet or if there are no Email clients installed, copy either the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client to email the files to Micro Focus SupportLine at `supportline@microfocus.com` together with the Support Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues that you are experiencing.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that contains the details about your environment, product, and settings. The mfsupport script is stored in `$COBDIR/bin`.

**To run mfsupport:**

1. Start a UNIX shell.
2. Set `COBDIR` to the product with issues.
3. Execute `mfsupport` from a directory where you have write permissions.
   
   **This creates a log file, `mfpoll.txt`, in that directory.**
4. When the script finishes, send the `mfpoll.txt` file to your Micro Focus SupportLine representative.
Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the installed Micro Focus products.

If COBDIR is set to a location that does not contain etc/cobver or COBDIR is not set, mfsupport gives you the option to search your machine for possible product locations. Note that the search can take some time if you have a large amount of disc storage and files.

Creating Debug Files

If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine, your support representative might request that you provide additional debug files (as well as source and data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
Copyright and Disclaimer

© Copyright 2019 Micro Focus or one of its affiliates.

The only warranties for this product and any associated updates or services are those that may be described in express warranty statements accompanying the product or in an applicable license agreement you have entered into. Nothing in this document should be construed as creating any warranty for a product, updates, or services. The information contained in this document is subject to change without notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall not be liable for any technical or other errors or omissions in this document. Please see the product's applicable end user license agreement for details regarding the license terms and conditions, warranties, and limitations of liability.

Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control over and is not responsible for information on third party sites.

This product includes software developed by Computing Services at Carnegie Mellon University (http://www.cmu.edu/computing/).